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Innledning

Takk for at du valgte Medtronic Diabetes som din partner på veien til å hjelpe pasienter med

diabetes med å få bedre kontroll over sykdommen. Vi  er sikker på at du vil få nytte av

CareLink® Pro-programvaren, som er basert på nyeste teknologi og et enkelt,  menybasert

brukergrensesnitt.

Med CareLink Pro kan du registrere, lagre og rapportere pasientbehandlingsdata og

diagnostiske data. Du kan også bruke denne programvaren til  å få tilgang til data fra pumpe,

blodsukkermåler og sensor som pasienten har lastet opp til  CareLink® Personal – et nettbasert

administrasjonssystem som brukes sammen med CareLink Pro.

Funksjoner 

CareLink Pro er en programvare for diabetesbehandling, og den installeres på en datamaskin.

Den har følgende funksjoner:

• Det kan opprettes pasientjournaler for lagring av data fra pasientens utstyr, samt

behandlingsdata fra pasientens CareLink Personal-konto.

• Data fra insulinpumper, monitorer og blodsukkermålere kan sendes til systemet, lagres og

deretter brukes til å lage rapporter.

• Det kan eventuelt kobles sammen med CareLink Personal-systemet for å få tilgang til

utstyrsdata som pasienten har lagret på dette systemet. Dette er ideelt for å lage oppdaterte

rapporter mellom konsultasjoner, og det kan redusere behovet for å lese av utstyrsdata

under konsultasjonen.

• Det kan lages forskjellige behandlingsrapporter fra utstyrsdataene som er lagret i

pasientjournalen. Slike rapporter gjør det lettere å svare på spørsmål om behandlingen, som

for eksempel pasientrespons, mønstre og unntak.

• Systemet varsler deg når nye programvareoppdateringer kan lastes ned og installeres.

Dermed er du sikker på alltid å ha de nyeste funksjonene.

• Programvaren har en Guide Me-funksjon som kan hjelpe nye brukere av CareLink Pro.

Brukerne får tips og hjelp til oppgaver de holder på med.
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• Den har et integrert hjelpesystem som gir informasjon om forskjellige områder.

Sikkerhet 

• CareLink Pro kan beskyttes med passord.

• Overføring av pasientdata fra CareLink Personal er kryptert med industristandarden SSL-

teknologi (Secure Sockets Layer).

Relevant dokumentasjon

Denne dokumentasjonen fra Medtronic MiniMed inneholder detaljert utstyrsspesifikk

informasjon som ikke er inkludert i  denne brukerhåndboken.

MERK! Blodsukkermålere fra andre produsenter: se instruksjonene fra produsenten som
følger med blodsukkermåleren.

• Brukerhåndbok for Paradigm-insulinpumpen

• Brukerhåndbok for Guardian REAL-Time-monitoren

• Brukerhåndbok for sensorfunksjoner

• Brukerhåndbok for ComLink

• Brukerhåndbok for CareLink USB

Brukerhjelp

Kontakt den lokale representanten hvis du trenger ytterligere hjelp vedrørende dette

systemet. På følgende nettsted finner du internasjonal kontaktinformasjon:

http://www.medtronicdiabetes.com/help/contact/locations.html

Utstyr som støttes

CareLink Pro henter data fra følgende utstyr.

MERK! Det kan hende at noe av utstyret som kan brukes sammen med denne

programvaren, ikke er tilgjengelig i  alle land der programvaren er godkjent for bruk.
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Insulinpumper/glukosemonitorer 

Medtronic MiniMed-pumper: 508

Medtronic MiniMed Paradigm®-pumper: 511, 512, 712, 515, 715, 522,  722, 522K, 722K,
Paradigm® Veo™ (554, 754)

Guardian REAL-Time-monitorer:
CSS-7100

CSS-7100K

Produsent Blodsukkermålere

Blodsukkermålere som er kompatible med Medtronic
Diabetes-produkter:

• Bayer CONTOUR® LINK

• BD Paradigm Link®-blodsukkermåler

LifeScan:

• OneTouch® UltraSmart®

• OneTouch® Profile®

• OneTouch® Ultra®

• OneTouch® Basic®

• OneTouch® FastTake®

• OneTouch® SureStep®

• OneTouch® Ultra® 2

• OneTouch® UltraMini®

• OneTouch® UltraEasy®

Bayer:

• Ascensia BREEZE®

• BREEZE® 2

• CONTOUR®

BD: • Logic®

Bayer Ascensia® DEX®-serien, inkludert følgende
kompatible blodsukkermålere:

• Ascensia® DEX®

• Ascensia® DEX® 2

• Ascensia® DEXTER-Z® II

• Glucometer® DEXTER-Z®

• Ascensia® ESPRIT® 2

• Glucometer® ESPRIT®

• Glucometer® ESPRIT® 2

Bayer Ascensia ELITE™-serien, inkludert følgende
kompatible blodsukkermålere:

• Ascensia ® ELITE™

• Glucometer ELITE® XL

Abbott:

• FreeStyle®

• FreeStyle® Lite®

• FreeStyle® Freedom®

• FreeStyle® Freedom Lite®

• Precision Xtra™

• TheraSense FreeStyle®

• FreeStyle® Flash®

• FreeStyle® Papillon™ mini

• FreeStyle® Mini®

• Optium Xceed™

• Precision Xceed™

Roche:

• Accu-Chek® Aviva

• Accu-Chek® CompactPlus

• Accu-Chek® Compact

• Accu-Chek® Active
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Kommunikasjonsutstyr

Com-Station
Til bruk sammen med Medtronic MiniMed 508-
pumpe. (Du finner informasjon om nødvendig
maskinvare i brukerhåndboken for Com-Station.)

ComLink

Til bruk sammen med MiniMed Paradigm-pumpe
og Guardian REAL-Time-monitor. (Du finner
informasjon om nødvendig maskinvare i
brukerhåndboken for ComLink.)

Blodsukkermåleren Paradigm Link®

Til bruk sammen med MiniMed Paradigm-pumpe
eller Guardian REAL-Time-monitor. (Du finner
informasjon om nødvendig maskinvare i
brukerhåndboken for Paradigm Link®-
blodsukkermåler.)

CareLink® USB Til bruk sammen med MiniMed Paradigm-pumpe
og Guardian REAL-Time-monitor.

Datakommunikasjonskabel

Til bruk sammen med blodsukkermålere fra andre
produsenter.  Alle produsenter av
blodsukkermålere leverer en
datakommunikasjonskabel.

Merk! Hvis produsenten av blodsukkermåleren
leverer en USB-kabel i  stedet for en seriekabel til
opplasting av data, må du installere
programvaredriveren fra denne produsenten.

Sjekk også med produsenten at USB-driveren er
kompatibel med operativsystemet ditt.  Enkelte
USB-drivere kan ikke brukes på 64 bits
operativsystemer.

Tilsvarende utstyr

Når du skal legge til et apparat i systemet, velger du produsent og modell  fra en liste. Hvis

apparatets produsent og modell ikke er i  listen, kan du bruke tabellen under til  å finne et

tilsvarende apparat som kan velges.

Hvis pasienten bruker ett av disse apparatene Velg dette apparatet

• Bayer Ascensia® DEX® 2

• Bayer Ascensia® DEXTER-Z® II

• Bayer Glucometer® DEXTER-Z®

• Bayer Ascensia® ESPRIT® 2

• Bayer Glucometer® ESPRIT®

• Bayer Glucometer® ESPRIT® 2

Bayer Ascensia® DEX®

Bayer Glucometer ELITE® XL Bayer Ascensia ELITE™

Precision Xceed™ Optium Xceed™

Bestilling

Kontakt den lokale representanten når du skal bestille produkter fra Medtronic Diabetes. På

følgende internettadresse finner du internasjonal kontaktinformasjon:

http://www.medtronicdiabetes.com/help/contact/locations.html

CareLink Pro Brukerhåndbok   Innledning 4

http://www.medtronicdiabetes.com/help/contact/locations.html


MERK! Blodsukkermålere kan bestilles fra de respektive produsentene.

Hvordan bruke denne brukerhåndboken

MERK! Denne brukerhåndboken viser bare eksempler på skjermbilder. Skjermbildene på

din programvare kan være litt  annerledes.

I  ordlisten finner du definisjoner av uttrykk og funksjoner. Ord, uttrykk og symboler som

benyttes i denne brukerhåndboken, står i  tabellen nedenfor.

Term/stil Betydning

Klikk Trykk på venstre museknapp over et element på
skjermen for å velge det.

Dobbeltklikk Trykk to ganger på venstre museknapp over et
element på skjermen for å åpne det.

Høyreklikk Trykk på høyre museknapp over et element på
skjermen for å åpne et annet vindu eller en meny.

Fet  tekst
Brukes for en knapp, et skjermbildenavn, et
feltnavn eller et menyvalg. For eksempel: Patient >
New Patient

MERK! Gir tilleggsinformasjon vedrørende en prosedyre
eller et trinn.

FORSIKTIG!
Advarer mot en potensiell fare som, hvis den ikke
unngås, kan føre til  mindre eller moderat skade på
programvaren eller utstyret.

ADVARSEL!
Gir deg melding om en potensiell fare som, hvis
den ikke unngås, kan føre til  alvorlig personskade
eller dødsfall.  Det kan også beskrive alvorlige
bivirkninger og faresituasjoner som kan oppstå.

Brukersikkerhet

Indikasjoner for bruk

CareLink Pro er ment som et verktøy som skal gjøre det enklere å håndtere diabetes.

Hensikten med dette systemet er å vise dataene som overføres fra insulinpumper,

blodsukkermålere og kontinuerlige glukosemonitorer,  som CareLink Pro-rapporter.

Rapportene inneholder informasjon som kan brukes til å se trender og kartlegge daglige

aktiviteter,  som karbohydratinntak, tidspunkter for måltider, insulintilførsel og

blodsukkerverdier.

Advarsler

• Dette systemet skal bare brukes av helsepersonell som er kjent med behandling av diabetes.

• Systemets rapporter er ikke beregnet til å gi medisinsk rådgivning og skal ikke brukes til det.
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• Dette produktet skal bare brukes sammen med utstyr som støttes som står nevnt i dette

dokumentet. (Se Utstyr som støttes på side 2.)

• Pasienter bør rådes til å kontrollere blodsukkeret minst 4–6 ganger daglig.

• Pasienter bør få anbefaling om å kontakte diabetesteamet før de gjør endringer i deres

diabetesbehandling.

• Pasienter bør få anbefaling om kun å ta avgjørelser angående behandlingen basert på

diabetesteamets retningslinjer og blodsukkerverdier, ikke basert på sensorglukoseverdier.

Kontraindikasjoner

Denne programvaren skal ikke brukes med utstyr som ikke står oppført i  Utstyr som støttes på

side 2.  Dette produktet blir heller ikke brukt i behandlingen av andre medisinske tilstander

enn diabetes.

Før du åpner dette programmet, må du lukke følgende programmer hvis de er åpne:

• CGMS® System Solutions™-programvare (7310)

• Solutions® Pumps & Meters-programvare (7311)

• Guardian® Solutions®-programvare (7315)

• ParadigmPAL™ (7330)

• CareLink® Personal-programvare (7333)

• Solutions®-programvare for CGMS®iPro (7319)
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Komme i gang

Her finner du informasjon om hvordan du starter CareLink Pro-programmet, åpner og lukker

pasientjournaler og definerer innstillinger som gjelder for alle pasientene i systemet.

Før du begynner

Hvis dette er første gang du bruker CareLink Pro, må du fylle ut General preferences

(Generelle innstillinger). Se Generelle innstillinger på side 12.  Disse innstillingene bestemmer

hvordan visse elementer vises i programvaren og i  rapporter,  samt hvordan du ønsker at

systemet skal kommunisere med Internett.

Innstillingene kan defineres når som helst.  Det kan være hensiktsmessig å vente med å

definere de andre innstillingene til du har gjort deg kjent med CareLink Pro.

Grunnleggende systemoppgaver 

I  tabellen nedenfor ser du hvilke hovedoppgaver du antakelig kommer til  å utføre når du

konfigurerer og bruker CareLink Pro for første gang. Tabellen viser også hvor i

brukerhåndboken du kan finne informasjon om de ulike oppgavene.

Trinn Sted

Gjøre deg kjent med brukergrensesnittet i  CareLink Pro. Navigere i  systemet på side 8

Definere de generelle systeminnstillingene som skal
brukes av diabetesteamet Definere systeminnstillinger på side 11

Opprette profiler for alle pasientene. Legge til  nye profiler på side 20

Koble deg til pasientenes CareLink Personal-kontoer. Koble seg til  CareLink Personal på side 21

Legge til pasientens pumpe og blodsukkermålere i
profilen. Legge til  utstyr  på side 28

Lese av data fra pasientens pumpe og
blodsukkermålere. Lese av utstyrsdata på side 34

Definere og lage rapporter for alle pasientene. Lage rapporter på side 37
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Trinn Sted

Ta regelmessige sikkerhetskopier av CareLink Pro-
databasen. Sikkerhetskopiere databasen på side 48

Oppdatere CareLink Pro. Laste ned programvareoppdateringer på side 47

Navigere i systemet

Før du bruker CareLink Pro-programvaren, må du gjøre deg kjent med brukergrensesnittet.

Brukergrensesnittet omfatter menyer, en verktøylinje, et navigeringsfelt,  arbeidsområder og

et Guide Me-vindu.

Åpne CareLink Pro

1 Dobbeltklikk på CareLink Pro-ikonet  på skrivebordet på datamaskinen, eller velg

Medtronic CareLink Pro  fra programlisten i Start-menyen i Windows.

Påloggingsbildet vises hvis du må logge deg på med passord.

a. Skriv inn passordet i feltet Password (Passord).

MERK! Pålogging med passord er en valgfri funksjon som stilles inn under

installasjonen.

b. Klikk på LOGIN (Logg på).

Oppstartbildet vises.

2 Klikk på New Patient (Ny pasient)  hvis du vil opprette en ny pasientjournal. Klikk på Open

Patient (Åpne pasient)  hvis du vil åpne en pasientjournal fra en liste over pasienter i

systemet.

Arbeidsområder

Hvis en pasientjournal er åpen, kan du klikke på en av knappene i navigeringsfeltet for å vise

det tilhørende arbeidsområdet. Bruk disse arbeidsområdene til  å skrive inn eller velge

informasjon når du skal utføre CareLink Pro-oppgaver for pasienten.

Profile (Profil):  Her kan du legge inn
pasientinformasjon som navn og fødselsdato.
Du kan også koble deg til en pasients
CareLink Personal-konto fra dette
arbeidsområdet.

Devices (Utstyr): Her kan du lagre
informasjon som trengs for å lese av en
pasients utstyr.

Reports (Rapporter): Her kan du definere
parametere og velge hvilke rapporter som
skal lages for pasienten.
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Det er bare arbeidsområdet Profile (Profil)  som er tilgjengelig for en pasient til  det er

opprettet og lagret en profil  for pasienten. Det er bare arbeidsområdene Profile (Profil)  og

Devices (Utstyr) som er tilgjengelige for en pasient til det er lagt til utstyr for pasienten.

Verktøylinje 

Verktøylinjen i CareLink Pro gir deg rask tilgang til  vanlige funksjoner. Verktøylinjen

inneholder følgende knapper:

Knapp Navn Funksjon

Legg til pasient
Åpner arbeidsområdet Profile
(Profil)  slik at du kan legge til en
ny pasientjournal i  systemet.

Åpne pasient

Åpner tabellen Patient Lookup
(Pasientsøk) der du kan velge å
åpne en eksisterende
pasientjournal.

Guide Me

Viser eller skjuler Guide Me-
vinduet. Klikk på denne
knappen hvis du ønsker
kontekstavhengig hjelp.

Pasientfaner

Etter at du har åpnet en pasientjournal,  vises det en fane med pasientens navn under

verktøylinjen. Når en fane er aktiv, betyr det at pasientjournalen og arbeidsområdet er aktive,

og du kan utføre CareLink Pro-oppgaver for pasienten.

For å gjøre en pasientjournal aktiv slik at du kan arbeide med den, klikker du på fanen for den

aktuelle pasienten. Klikk på Lukk-knappen  på pasientfanen for å lukke journalen.

Guide Me-funksjonen 

Guide Me-funksjonen er tilgjengelig i  alle deler av CareLink Pro. Funksjonen innebærer at det

åpnes et vindu med kontekstavhengig hjelp og tips til  handlinger som kan utføres i den delen

av systemet som er aktiv. Guide Me-vinduene kan også inneholde lenker til  >>learn more
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(lær mer).  Når du klikker på disse lenkene, åpnes den aktuelle siden i hjelpesystemet med mer

informasjon. Guide Me-funksjonen er aktivert som standard. Du kan imidlertid slå den av når

som helst.

Slå Guide Me-funksjonen på og av

Slik slår du Guide Me-funksjonen på eller av:

• Klikk på Guide Me-knappen. 

• Velg Help  > Guide Me (Hjelp > Guide Me).

Åpne pasientjournaler

Opptil seks pasientjournaler kan være åpne samtidig. Se Legge til  nye profiler på side 20

hvis du ikke har opprettet noen pasientprofiler ennå.

1 Gå til File > New Patient  (Fil > Ny pasient), eller klikk på Åpne pasient-knappen.  Det

vises en pasientliste som ser omtrent slik ut:

CareLink Pro Brukerhåndbok   Komme i gang 10



MERK! Hvis du får melding om at for mange pasientjournaler er åpne, klikker du på

OK, lukker en journal og fortsetter.

2 Søk etter pasienten ved å skrive inn hele eller deler av pasientens navn i feltet Find a Patient

(Søk etter pasient).  Når pasienten du søkte etter er markert, kan du klikke på OPEN (Åpne),

dobbeltklikke på raden eller trykke på ENTER. Du kan også bla i listen ved hjelp av pil opp og

pil ned på tastaturet.

Arbeidsområdet Devices (Utstyr) (hvis du ikke har lagt til utstyr ennå) eller Reports

(Rapporter) vises for pasienten.

3 Klikk på Profil-knappen  i navigeringsfeltet hvis du vil vise arbeidsområdet Profile

(Profil).

Lukke pasientjournaler 

1 Kontroller at pasientjournalen du ønsker å lukke, er aktiv (fanen er markert).

2 Gjør ett av følgende:

a. Velg File > Close Patient  (Fil > Lukk pasient).

b. Klikk på Lukk-knappen  på pasientfanen.

c. Trykk på Ctrl+F4.

Definere systeminnstillinger 

Disse innstillingene gjelder for alle pasientene i systemet. Du finner informasjon om

innstillinger som bare påvirker enkelte pasienter,  under Kontrollere rapportinnstillinger på

side 40.

Innstillingene vises i følgende grupper:

• General (Generelt)

- Glukoseenheter

- Karbohydratenheter

- Kommunikasjon

- Feilsøking

• Patient Profile (Pasientprofil)

- Velg og rangér datafelter i  pasientprofiler.

• Patient Lookup (Pasientsøk)

- Endre rekkefølgen på feltene som vises når du velger Open Patient (Åpne pasient) for å

vise en liste med pasienter.

• Report Generation (Rapportgenerering)

- Velg hvilke felt som skal vises når du velger hva som skal inngå i Daily Detail-rapportene,

i datatabellen.
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Generelle innstillinger

Bruk fanen General (Generelt) for å definerer hvordan programvaren skal vise visse typer

informasjon, og for å definere innstillingene for ekstern kommunikasjon.

1 Klikk på fanen General (Generelt)  hvis den ikke allerede er aktiv.

2 Gå til Tools > Options (Verktøy > Alternativer). Følgende vindu vises:

3 Klikk på alternativknappen for den verdien du ønsker:

- Glucose Units (Glukoseenheter):  mg/dL eller mmol/L

- Carbohydrate Units (Karbohydratenheter):  grams (gram) eller Exchanges (bytter)

a. Hvis du velger Exchanges (Bytter)som karbohydratenhet, må du føre inn riktig tall i

feltet grams are equal to 1 Exchange (gram er lik 1 bytte).

4 Merk av eller fjern merket i boksen under Chart Options > Overview Report

(Tabellalternativer > Oversiktsrapport). Hvis boksen er merket av, vil programmet koble

sammen blodsukkerverdiene på blodsukkermåleroversikten med linjer.  (Dette er en tabell

som vises i oversiktsrapporten for sensoren og blodsukkermåleren.)

5 Merk av (aktiver) eller fjern merket (deaktiver) i  boksen ved siden av følgende

kommunikasjonsinnstillinger:

MERK! Pass på at du følger diabetesteamets eller IT-avdelingens retningslinjer når du

definerer kommunikasjonsinnstillingene.
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- Automatically check for software updates (Søk etter programvareoppdateringer
automatisk):  Hvis denne funksjonen er valgt, sendes det en melding til alle systemene

som kjører CareLink Pro, når en programvareoppdatering er tilgjengelig. Brukeren har da

mulighet til å laste ned og installere oppdateringene. Hvis du foretrekker kontrollert

distribusjon av programoppdateringer, kan du fjerne merket i denne avmerkingsboksen.

- Synchronize with Medtronic CareLink® Personal (Synkronisere med Medtronic

CareLink® Personal):  Hvis du ønsker at systemet skal synkronisere pasientenes CareLink

Personal-data automatisk hver gang du åpner en profil, kan du merke av i denne boksen.

Hvis du fjerner merket i denne boksen, må du synkronisere CareLink Personal-data

manuelt for hver pasient.

6 Merk av eller fjern merket i boksen under Troubleshooting (Feilsøking).  Hvis boksen er

merket av, lagrer programmet en rapport med utstyrsavlesinger med tanke på feilsøking.

7 Klikk på OK for å lagre de generelle innstillingene.

Innstillinger for pasientprofil

Dette er en generell  innstilling som definerer innholdet i profilene. Du kan definere feltene i

arbeidsområdet Profiles (Profiler) slik at det inneholder informasjonen som er mest relevant.

Du kan legge til eller fjerne felter, opprette egendefinerte felter og endre rekkefølge på

feltene i  vinduet.

1 Gå til Tools > Options (Verktøy > Alternativer).

2 Klikk på fanen Patient Profile (Pasientprofil). Følgende vindu vises:

MERK! Bruk avmerkingsboksene til  å velge hvilke felter du vil ha med i profilen. Bruk

pil opp og pil ned til  å sortere feltene i  riktig rekkefølge.
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Velge datafelter 

1 Merk av i boksene for å legge til de feltene du ønsker.

MERK! Fornavn og etternavn kan ikke fjernes.

2 Fjern merket i boksen hvis du vil fjerne et felt fra profilen.

3 Hvis et felt skal være obligatorisk, merker du av i boksen i kolonnen Required (Obligatorisk).

Alle felter som er obligatoriske, må fylles ut før en profil kan opprettes.

Legge til egendefinerte felter 

1 Merk av i boksen til venstre for et tomt felt under Custom (Egendefinert).

2 Skriv inn tekst for å gi feltet et navn (f.eks. Nærmeste pårørende). Dette feltnavnet vises på

pasientens profil.

3 Hvis feltet skal være obligatorisk, merker du av i boksen i kolonnen Required (Obligatorisk).

MERK! Hvis du vil fjerne et egendefinert felt fra profilen, fjerner du merket i  boksen

ved siden av feltet/feltene du ønsker å fjerne.

Velge rekkefølgen på datafeltene 

Velg det feltet du ønsker å flytte, og klikk på pil opp eller pil  ned  for å flytte det. (Pilene

øverst og nederst brukes til å flytte et felt helt  til begynnelsen eller slutten av listen.)

Fullføre innstillingene for pasientprofil

Klikk på OK  når du har fått med alle feltene du ønsker i  riktig rekkefølge.

Pasientprofilene innholder nå alle feltene som du nettopp valgte, i  riktig rekkefølge.

Innstillinger for pasientsøk 

Tabellen Patient Lookup (Pasientsøk) brukes til å søke etter og åpne en pasientjournal. Tabellen

inneholder alle pasienter i databasen og informasjon fra pasientens profil som identifiserer

pasienten. Du kan definere hva slags informasjon som skal vises i denne tabellen, og

rekkefølgen på kolonnene. Slik definerer du tabellen for pasientsøk:

1 Gå til Tools > Options (Verktøy > Alternativer).
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2 Klikk på fanen Patient Lookup (Pasientsøk).  Følgende vindu vises:

MERK! Bruk avmerkingsboksene til  å velge hvilke data du vil ha med i tabellen

Patient Lookup (Pasientsøk). Bruk pil opp og pil ned til  å sortere kolonnene i  riktig
rekkefølge.

Velge hvilke data som skal vises 

Bruk avmerkingsboksene til å velge hvilken type data du ønsker å vise, eller til  å fjerne data du

ikke ønsker å vise, i  tabellen Patient Lookup (Pasientsøk).

Endre rekkefølgen på kolonnene 

Hvis du vil  endre rekkefølgen på kolonnene i tabellen Patient Lookup (Pasientsøk),  kan du

velge den kolonnen du vil flytte, og klikke på pil  opp eller pil  ned.  (Pilene øverst og

nederst brukes til  å flytte en kolonne helt til  begynnelsen eller slutten av listen.)

Kolonnen som står øverst på listen Column Display Order, vises som den første kolonnen i

tabellen Patient Lookup. Kolonnen nederst vises som den siste kolonnen i tabellen.

Fullføre innstillingene for pasientsøk

Klikk på OK  når du har fått med alle datatene du ønsker i riktig rekkefølge.

Tabellen Patient Lookup (Pasientsøk) inneholder nå dataene og kolonnerekkefølgen du

nettopp valgte.
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Innstillinger for rapportgenerering 

Datatabellen vises i vinduet for valg og generering av rapporter.  Denne tabellen brukes ved

generering av rapporter. Den inneholder daglig informasjon fra pasientens utstyr og

eventuelt CareLink Personal-kontoen. Dataene i  denne tabellen hjelper deg til  å bestemme

hvilke dager som krever en Daily Detail (Daglig detaljer)-rapport.  Den hjelper deg også til  å

avgjøre hvilke andre rapporter som bør lages.

Klinikken kan definere hvilke data som skal vises i denne tabellen, inkludert rekkefølgen de

skal vises i,  for å gjenspeile hva som er mest relevant.

MERK! Du finner mer informasjon om hvordan disse innstillingene påvirker datatabellen,

under Velge rapporttyper og datoer som skal tas med på side 42.

1 Gå til Tools > Options (Verktøy > Alternativer).

2 Klikk på fanen Report Generation (Rapportgenerering).  Følgende vindu vises:

Velge hvilke data som skal vises 

Bruk avmerkingsboksene til å velge hvilken type data du ønsker å vise, eller til  å fjerne data du

ikke ønsker å vise i datatabellen.

Følgende data er tilgjengelig:

Kolonneoverskrift Definisjon

№ of Meter Readings (Ant. blodsukkermålerverdier) Antallet verdier som er registert med det aktuelle
utstyret på den aktuelle datoen.

Meter Readings Average (Gj.snitt for
blodsukkermålerverdier)

Gjennomsnittet av blodsukkerverdiene som er
registrert med det aktuelle utstyret.
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Kolonneoverskrift Definisjon

Sensor Duration (Opptakets varighet) Total lengde på opptak av sensordata på den
aktuelle datoen. Verdiene er --  (ingen), 0:05–24:00.

Sensor Average (Sensorgjennomsnitt) Gjennomsnittet av sensorverdiene som er registrert
på den aktuelle datoen.

Highest Reading (Høyeste verdi) Den høyeste verdien (fra en sensor eller
blodsukkermåler) på den aktuelle datoen.

Lowest Reading (Laveste verdi) Den laveste verdien (fra en sensor eller
blodsukkermåler) på den aktuelle datoen.

Avg AUC Below Target (Gj.snitt.  AUK under målet) Gjennomsnittlig areal under kurven er under
pasientens målområde.

Avg AUC Above Target (Gj.snitt.  AUK over målet) Gjennomsnittlig areal under kurven er over
pasientens målområde.

Total Carbs (Karb. totalt)

Summen av alle karbohydratmengder (avrundet til
nærmeste gram eller nærmeste bytte på 0,1,
avhengig av hvilken måleenhet som er brukt) som
er rapportert i  løpet av dagen gjennom Bolus
Wizard-hendelser eller karbohydratmarkører på
pumpen eller Guardian-monitoren.

Suspend Duration (Varighet stoppet) Tidsrommet pumpen er stoppet på den aktuelle
datoen. Verdiene er -- (ingen), 0:01–24:00.

№ of Rewinds (Ant. reverseringer) Antallet reverseringshendelser på den aktuelle
datoen.

№ of Primes (or Fills) (Ant. priminger (eller fyllinger)) Antallet primehendelser (eller fyllehendelser) som er
registrert på den aktuelle datoen.

Prime (or Fill) Volume (U) (Primevolum (eller
fyllevolum) (E))

Det totale volumet insulin som er brukt til
primehendelser (eller fyllehendelser) på den aktuelle
datoen.

Total Insulin (U) (Insulin totalt  (E)) Det totale volumet insulin som er gitt på den
aktuelle datoen, som registrert av pumpen.

Total Basal  (U) (Basal totalt  (E))
Det totale volumet basalinsulin som er gitt på den
aktuelle datoen (det totale volumet insulin minus
summen av alle boluser).

Total Bolus (U) (Bolus totalt (E)) Det totale volumet insulin som er gitt som boluser
på den aktuelle datoen, som registrert av pumpen.

Basal  % Viser forholdet (i  hele prosenter) mellom basalinsulin
og den totale mengden insulin.

Bolus % Viser forholdet (i  hele prosenter) mellom bolusinsulin
og den totale mengden insulin.

№ of Boluses (Ant. boluser) Antallet bolushendelser som er registrert på den
aktuelle datoen.

Bolus Wizard Events (Bolus Wizard-hendelser) Det totale antallet Bolus Wizard-hendelser som er
registrert på den aktuelle datoen.

Bolus Wizard Overrides (Bolus Wizard-overstyringer) Antallet Bolus Wizard-hendelser der mengden tilført
insulin er ulik den anbefalte mengden.

№ of Meal Boluses (Ant. matboluser)
Antallet Bolus Wizard-hendelser med
karbohydratmengder over null som er registrert på
den aktuelle datoen.

№ of Correction Boluses (Ant. korrigeringsboluser)
Antallet Bolus Wizard-hendelser med
korrigeringsboluser over null  som er registrert på
den aktuelle datoen.

№ of Manual Boluses (Ant. manuelle boluser)
Antallet bolushendelser som er registrert på den
aktuelle datoen, som ikke er Bolus Wizard-
hendelser.
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Endre rekkefølgen på kolonnene 

Hvis du vil endre rekkefølgen på kolonnene i datatabellen, kan du velge den kolonnen du vil

flytte og klikke på pil  opp eller pil ned.  (Pilene øverst og nederst brukes til å flytte en

kolonne helt  til begynnelsen eller slutten av listen.)

MERK! Elementene som står øverst på listen Column Order, vises som den første kolonnen

i datatabellen. Elementene nederst vises som den siste kolonnen i datatabellen.

Fullføre innstillingene for rapportgenerering

Klikk på OK  når du har fått med alle datatene du ønsker i riktig rekkefølge.

Datatabellen inneholder nå dataene og kolonnerekkefølgen du nettopp valgte.
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3

Profiler

En profil tilsvarer forsiden på en journal.  Den inneholder pasientdata som navn og

fødselsdato. Du må opprette en profil før du kan hente data fra utstyret og bruke dem i

behandlingsrapporter.

I  arbeidsområdet Profile (Profil)  kan du også koble deg til  en pasients CareLink Personal-

konto. Når du er koblet til, kan du hente pasientdata fra CareLink Personal når som helst, uten

at pasienten trenger å være til  stede.

Før du begynner

Det kan være lurt å tilpasse pasientprofilene slik at de bare inneholder den typen informasjon

du ønsker å samle inn. Du finner mer informasjon om dette under Innstillinger for pasientprofil

på side 13.
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Du trenger også et brukernavn og et passord når du kobler deg til  en pasients CareLink

Personal-konto. Pasienten må være til stede for å gi deg disse dataene.

Legge til nye profiler 

Hver gang du legger til en pasient i  CareLink Pro-systemet, må du begynne med å fylle ut en

profil for pasienten.

1 Gå til File > New Patient  (Fil > Ny pasient), eller klikk på Legg til pasient-knappen. 

Arbeidsområdet Profile (Profil) vises.

MERK! Hvis du vil legge til  eller endre felter i  pasientprofilen, klikker du på customize

fields (definere felter). Se Innstillinger for pasientprofil  på side 13.

2 Fyll ut feltene under Patient Profile (Pasientprofil).

3 Klikk på SAVE (Lagre).

Den nye pasientprofilen er lagt til i CareLink Pro-databasen. Det vises en melding om at

profilen ble lagret.

Fylle ut obligatoriske felter

1 Hvis et obligatorisk felt ikke er fylt ut når du lagrer en pasientprofil, vises det en melding ved

siden av feltet. Du kan ikke lagre profilen før du har fylt ut feltet.

2 Fyll ut feltet.

3 Klikk på SAVE (Lagre).

4 Når bekreftelsesmeldingen vises, klikker du på OK.

Redigere pasientprofiler

1 Kontroller at arbeidsområdet Profile (Profil)  er åpent for pasienten.

2 Klikk på EDIT (Rediger).

3 Rediger dataene som skal endres, under Patient Profile (Pasientprofil).

4 Klikk på SAVE (Lagre).

Det vises en melding om at profilen ble lagret.

Slette pasientdata fra systemet 

1 Kontroller at arbeidsområdet Profile (Profil)  er åpent for pasienten.

2 Kontroller at det er denne pasienten du vil slette. Hvis en pasientprofil slettes, fjernes alle

dataene for pasienten fra CareLink Pro-databasen. Denne handlingen kan ikke angres.
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3 Klikk på >> delete patient record (slett pasientjournal)  over synkroniseringsdelen av

profilen.

Det vises en melding der du gjøres oppmerksom på at alle pasientdataene slettes når du

sletter journalen.

4 Klikk på Yes (Ja)  for å slette pasientjournalen.

Koble seg til CareLink Personal

Hvis pasienten tillater det, kan du koble deg til  pasientens CareLink Personal-konto. Dette er

et nettbasert verktøy som pasienten kan bruke til  å laste opp og lagre data fra utstyret og lage

en rekke behandlingsrapporter.

Når du har koblet deg til pasientens CareLink Personal-konto, kan du hente utstyrsdata som

pasienten har lagret der. Dette er ideelt for å opprette CareLink Pro-behandlingsrapporter

mellom oppfølgingskontrollene. Dette reduserer også behovet for å lese av pasientens utstyr

på kontoret.

Hvis en pasient ikke har opprettet en CareLink Personal-konto ennå, kan du sende pasienten

en e-post der du inviterer vedkommende til å opprette en konto.

Koble seg til en eksisterende konto 

MERK! Pasienten må være til  stede for at disse trinnene skal kunne fullføres.

1 Kontroller at du er koblet til Internett.

2 Åpne arbeidsområdet Profile (Profil)  for pasienten.

3 Kontroller at alle obligatoriske felter under Patient Profile (Pasientprofil) er fylt ut.

4 Klikk på LINK TO EXISTING ACCOUNT (Koble til en eksisterende konto).

Påloggingssiden for CareLink Personal vises.

5 Be pasienten om å gjøre følgende:

a. Skrive inn Username (Brukernavn) og Password (Passord).

b. Klikke på Sign In (Logg deg på).

Siden Grant Access (Gi tilgang)  vises, ut fra de innstillingene for språk og land som

pasienten har valgt under registreringen.

6 Be pasienten om å gjøre følgende:

a. Lese Terms of Use (Vilkår for bruk).

b. Merke av i boksen ved siden av I  agree to the Terms of Use above... (Jeg samtykker i

vilkårene for bruk over...).

c. Klikke på Grant Access (Gi tilgang).

d. Gi beskjed når siden Thank You (Takk)  vises.

7 Du kan skrive ut vilkårene for bruk til pasienten ved å klikke på Print (Skriv ut).  Du er nå

koblet til pasientens CareLink Personal-konto.
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Sende invitasjon på e-post 

Gjør følgende når du skal sende en e-post der du inviterer en pasient til å opprette en CareLink

Personal-konto:

1 Åpne arbeidsområdet Profile (Profil)  for pasienten.

2 Kontroller at alle obligatoriske felter under Patient Profile (Pasientprofil) er fylt ut.

3 Klikk på SEND E-MAIL INVITATION TO PATIENT (Send invitasjon til pasienten på e-post).

4 Kontroller at Patient Name (Pasientnavn),  Email Address (E-postadresse) og Language

(Språk)  er fylt ut riktig.

5 Klikk på SEND.

Det vises en melding i statusfeltet om at e-posten ble sendt.

Hente data fra en tilkoblet konto 

Hvis du er koblet til  en pasients CareLink Personal-konto, sendes alle nye data fra denne

kontoen automatisk hver gang du åpner pasientens profil  i  CareLink Pro.

MERK! For å forsikre deg om at dette skjer,  kan du gå til  Tools > Options > General
(Verktøy > Alternativer > Generelt) og kontrollere at boksen ved siden av "Synchronize

with CareLink Personal" (Synkroniser med CareLink Personal) er merket av.

Følg disse trinnene for å hente en pasients CareLink Personal-data når som helst etter at du

har åpnet pasientprofilen:

1 Kontroller at arbeidsområdet Profile (Profil)  er åpent for pasienten, og at du er koblet til

Internett.

2 Gå til Tools > Synchronize Patient Data (Verktøy > Synkroniser pasientdata).

Synkroniseringsikonet  på pasientfanen roterer.  Når ikonet stopper, er prosessen fullført.
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MERK! Hvis pasienten ikke lenger ønsker å dele CareLink Personal-dataene sine, vises

en melding som angir dette.

3 Alle ytterligere data som hentes fra CareLink Personal, vises i pasientrapportene.

Koble en pasients Carelink Personal-konto fra CareLink Pro

Du kan koble en pasients CareLink Personal-konto fra CareLink Pro. Dette er bare mulig etter at

en CareLink Personal-konto har blitt koblet til. Det hindrer CareLink Pro i å fortsette å hente

data fra pasientens CareLink Personal-konto. Det påvirker ikke pasientens egen bruk av CareLink

Personal-kontoen.

1 Åpne pasientjournalen og arbeidsområdet Profile (Profil)  for pasienten.

2 Klikk på UNLINK ACCOUNT (Koble fra konto).

3 Klikk på Yes (Ja) i bekreftelsesmeldingen. Pasientens profil er ikke lenger koblet til CareLink

Pro.

Statusen er endret til Not linked (Ikke tilkoblet),  og knappene LINK TO EXISTING

ACCOUNT (Koble til en eksisterende konto)  og SEND E-MAIL INVITATION TO PATIENT

(Send invitasjon til pasienten på e-post)  vises.

CareLink Pro Brukerhåndbok   Profiler 23



4

Maskinvareoppsett

For å kunne lese av data direkte fra utstyr og overføre dataene til  datamaskinen, må du ha

tilgang til  pasientens utstyr og eventuelle kabler eller annet nødvendig

kommunikasjonsutstyr.

Hvis pasienten har lastet opp utstyrsdataene til CareLink Personal-kontoen sin, kan du også få

tilgang til  dataene ved å koble deg til pasientens konto. Under Koble seg til  CareLink Personal

på side 21  finner du informasjon om tilkobling til en pasients CareLink Personal-konto.

Koble til utstyr

Se på oversiktsdiagrammet for å få et inntrykk av hvordan utstyr skal kobles til slik at det

kommuniserer med datamaskinen. De øvrige diagrammene viser detaljer ved

utstyrstilkoblingen.

Du finner mer informasjon i instruksjonene som vises i CareLink Pro mens du leser av utstyret.
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Oversikt over maskinvareoppsett 

Dette eksemplet viser hvordan CareLink USB brukes som kommunikasjonsutstyr mellom

pumpen og datamaskinen.

Eksempel på tilkobling av seriekabel og USB-kabel:
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ComLink (ekstrautstyr) sammen med pumper i Paradigm-serien:

Com-Station (ekstrautstyr) sammen med Medtronic MiniMed 508-pumper
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5

Utstyr

Informasjon du trenger for å lese av en pasients utstyr,  for eksempel merke, modell  og

serienummer, lagres i arbeidsområdet Devices (Utstyr).  Du trenger altså ikke å legge inn

informasjonen hver gang du leser av data fra utstyret.

Utstyr i  arbeidsområdet Devices (Utstyr) lagres i en av to lister – Active Devices (Aktivt utstyr)

eller Inactive Devices (Inaktivt utstyr).  Når du legger til  utstyr,  plasseres utstyret automatisk i

listen Active Devices (Aktivt utstyr). Du kan bare lese av data fra utstyr som vises i listen Active

Devices (Aktivt utstyr). Dette er sannsynligvis utstyret som pasienten bruker.

Annet utstyr som tilhører pasienten, men som ikke er i  bruk, kan lagres i  listen Inactive

Devices (Inaktivt utstyr).  Dette gjør at informasjonen lagres, slik at utstyret kan aktiveres når

som helst.
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Før du begynner

Før du kan åpne arbeidsområdet Devices (Utstyr) for en pasient, må det være lagret en profil

for pasienten i systemet. Se Legge til  nye profiler på side 20.

For at du skal kunne legge til  utstyr eller lese av data direkte fra utstyret, må utstyret

kommunisere med datamaskinen. I  Koble til  utstyr på side 24  finner du mer informasjon om

hvordan utstyr kobles til slik at det kommuniserer med datamaskinen.

Legge til utstyr 

Du kan hente data fra pasientens CareLink Personal-konto for utstyr som ikke er lagt til  ennå.

Slikt utstyr legges til  automatisk når data synkroniseres mellom CareLink Personal og CareLink

Pro.

MERK! Det kan bare være én aktiv pumpe per pasient. Hvis du legger til  en ny pumpe,

flyttes den tidligere pumpen til  den inaktive listen.

Legge til Medtronic-pumpe eller Guardian-monitor 

1 Kontroller at utstyret du legger til, er koblet til og kommuniserer med datamaskinen. (Du

finner tilkoblingsinstruksjoner under Koble til  utstyr på side 24.)

2 Klikk på pasientens fane eller dobbeltklikk på pasientens navn i tabellen Patient Lookup

(Pasientsøk).

3 Klikk på Utstyr-knappen  for å åpne arbeidsområdet Devices (Utstyr) for pasienten.

4 Klikk på ADD DEVICE (Legg til utstyr).

5 Velg Medtronic Pump/Guardian.  Veiviseren Add Medtronic Pump/Guardian (Legg til

Medtronic-pumpe/Guardian)  vises.

MERK! Pumpemodellen står på baksiden av pumpen eller på pumpens statusbilde.
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6 Velg knappen ved siden av det utstyret du vil legge til.

Hvis du har valgt MiniMed 508-pumpen,  går du videre til trinn 9.

7 Klikk på NEXT (Neste).  Siden Serial Number (Serienummer) vises.

MERK! Det vises en feilmelding hvis du skriver inn feil  serienummer. Se på eksemplene

på denne siden og kontroller at du har skrevet inn de samme tegnene som på
baksiden av pumpen. Skriv om nødvendig inn de seks tegnene på nytt.

8 Bruk eksemplene på denne siden til å finne det sekssifrede serienummeret på utstyret du skal

legge til. (Hvis du trenger mer hjelp med å finne nummeret, kan du klikke på >>learn more

(lær mer).)  Skriv inn de seks tegnene i feltet Device Serial Number (Utstyrets

serienummer).

9 Klikk på NEXT (Neste).  Det vises en side med Communication Options

(Kommunikasjonsalternativer)  som ser omtrent slik ut:

10 Klikk på nedtrekksmenyen Choose Port (Velg port)  og velg den porten som ComLink,

Paradigm Link®, CareLink USB eller Com-Station kobles til på datamaskinen. Hvis du ikke er

sikker på hvilken port du skal velge, velger du Auto Detect (or USB) (Autom. registrering

(eller USB)).
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11 Klikk på NEXT (Neste).  Siden Test Connection (Test tilkoblingen) vises og ser omtrent slik

ut:

12 Følg eventuelle utstyrsinstruksjoner og klikk på TEST.

En melding angir om tilkoblingen var vellykket. Hvis den var vellykket, går du videre til neste

trinn.

MERK! Denne testen innebærer ingen lesing av pumpedata; det kontrolleres bare at

kommunikasjonen mellom pumpen og datamaskinen fungerer.

Hvis den ikke var vellykket, må du kontrollere at maskinvaren mellom utstyret og

datamaskinen er koblet til riktig. Klikk også på BACK (Tilbake)  på sidene i veiviseren for å

kontrollere at du har lagt inn riktige utstyrsdata.

13 Klikk på DONE (Ferdig).

Utstyret legges til i  listen Active Devices (Aktivt utstyr).

Legge til en blodsukkermåler 

1 Klikk på pasientens fane eller dobbeltklikk på pasientens navn i tabellen Patient Lookup

(Pasientsøk).

2 Kontroller at blodsukkermåleren du legger til, kommuniserer med datamaskinen. (Du finner

tilkoblingsinstruksjoner under Koble til  utstyr på side 24.)

3 Klikk på Utstyr-knappen for å åpne arbeidsområdet Devices (Utstyr) for pasienten.

4 Klikk på knappen ADD DEVICE (Legg til utstyr).
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5 Velg Blood Glucose Meter (Blodsukkermåler).  Veiviseren Add Blood Glucose Meter (Legg

til blodsukkermåler)  vises.

6 Klikk på knappen for å velge merket på blodsukkermåleren.

7 Klikk på NEXT (Neste).  Siden Meter Model (Blodsukkermålermodell)  vises (denne siden

kan se forskjellig ut avhengig av produsenten av blodsukkermåleren).

8 Klikk på den blodsukkermålermodellen du skal legge til.
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9 Klikk på NEXT (Neste).  Siden Communication Options (Kommunikasjonsalternativer)
vises.

MERK! Du kan bare velge de alternativene som gjelder for blodsukkermåleren du

legger til.

10 Klikk på nedtrekksmenyen Choose Port (Velg port)  og velg den porten som ComLink,

Paradigm Link eller CareLink USB kobles til på datamaskinen. Hvis du ikke er sikker på hvilken

port du skal velge, velger du Auto Detect (or USB) (Autom. registrering (eller USB)).

11 Klikk på NEXT (Neste).  Siden Test Connection (Test tilkoblingen)  vises.

12 Følg instruksjonene som gis for blodsukkermåleren, og klikk på TEST.

En melding angir om tilkoblingen var vellykket. Hvis den var vellykket, går du videre til neste

trinn.
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Hvis den ikke var vellykket, må du kontrollere at maskinvaren mellom utstyret og

datamaskinen er koblet til riktig. Klikk også på BACK (Tilbake) i veiviseren for å kontrollere at

du har lagt inn riktige data.

13 Klikk på DONE (Ferdig).

Blodsukkermåleren legges til i  listen Active Devices (Aktivt utstyr).

Aktivere eller deaktivere utstyr 

Pasientutstyr kan flyttes mellom listen Active Devices (Aktivt utstyr) og Inactive Devices

(Inaktivt utstyr) etter behov. Utstyret må være aktivt for at du skal kunne lese data fra det.

Du kan ha så mange blodsukkermålere som du ønsker i listen Active Devices (Aktivt utstyr),

men bare én pumpe. Kontroller at du ønsker å deaktivere den aktuelle pumpen før du legger

til  en ny pumpe.

Deaktivere utstyr 

1 Klikk på pasientens fane eller dobbeltklikk på pasientens navn i tabellen Patient Lookup

(Pasientsøk).

2 Klikk på Utstyr-knappen for å åpne arbeidsområdet Devices (Utstyr) for pasienten. Utstyret

kan være oppført med et tilsvarende navn. Se Utstyr som støttes på side 2.

3 Klikk på >> make this device inactive (deaktiver dette utstyret)  under det utstyret du vil

deaktivere. Utstyret flyttes til listen Inactive Devices (Inaktivt utstyr).

Aktivere utstyr 

1 Klikk på pasientens fane eller dobbeltklikk på pasientens navn i tabellen Patient Lookup

(Pasientsøk).

2 Klikk på Utstyr-knappen. Arbeidsområdet Devices (Utstyr)  vises.

Utstyret kan være oppført med et tilsvarende navn. Se Utstyr som støttes på side 2.

3 Klikk på >> activate this device (aktiver dette utstyret)  under det utstyret du vil aktivere.

Utstyret flyttes til listen Active Devices (Aktivt utstyr).

Slette utstyr 

Gjør følgende hvis du vil slette utstyr og de tilhørende dataene fra arbeidsområdet Devices

(Utstyr) og CareLink Pro-systemet:

1 Klikk på pasientens fane eller dobbeltklikk på pasientens navn i tabellen Patient Lookup

(Pasientsøk).

2 Klikk på Utstyr-knappen for å åpne arbeidsområdet Devices (Utstyr)  for pasienten.

Utstyret kan være oppført med et tilsvarende navn. Se Utstyr som støttes på side 2.

3 Kontroller at utstyret står på listen Inactive Devices (Inaktivt utstyr).  Hvis ikke klikker du på

>> Inactivate this device (Deaktiver dette utstyret) på listen utstyret står på.
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4 Klikk på >> delete this device (slett dette utstyret)  under det utstyret du vil slette. Det vises

en melding der du gjøres oppmerksom på at utstyret og alle tilhørende data vil bli slettet fra

pasientjournalen.

5 Klikk på YES (Ja)  for å slette utstyret.

Utstyret og de tilhørende dataene slettes fra arbeidsområdet Devices (Utstyr)  og fra

CareLink Pro-systemet. Data fra dette utstyret kan ikke lenger brukes i rapporter.

Lese av utstyrsdata 

En måte å hente utstyrsdata på er å koble seg til pasientens eksisterende CareLink Personal-

konto. (Se Koble seg til  CareLink Personal på side 21.)  En annen måte er å lese av dataene

direkte fra utstyret,  som beskrevet her.

CareLink Pro kan lese data fra pasientens utstyr hvis utstyret står på listen Active Devices

(Aktivt utstyr) og kommuniserer med datamaskinen. Når du har fått dataene, kan du bruke

dem til å lage rapporter som hjelper deg med å vurdere pasientens behandling. Under Om

rapporter på side 43  finner du en kort beskrivelse av de tilgjengelige rapportene.

CareLink Pro kan innhente følgende data fra en insulinpumpe:

• ulike innstillinger på pumpen, som alarmmodus, lydstyrke og tid

• tilført basalinsulindose

• bolushendelser og tilført mengde

• Bolus Wizard-oppføringer

• primingvolum

• stoppmodusperioder

• sensorglukoseverdier i et bestemt tidsrom – gjelder pumper med sensor

Systemet kan også samle inn data fra et Guardian REAL-Time-system, blant annet:

• sensorglukoseverdier (SG-verdier)

• koeffisientverdier for glukosesensoren

• kalibreringsfaktorer for glukosesensoren

• måltidsmarkører

• insulininjeksjoner

I tillegg kan det hentes forskjellig informasjon fra blodsukkermålere under en opplasting.
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ADVARSEL! Avbryt eller fullfør alle midlertidige basaldoser eller aktive bolusdoser og slett

alle aktive alarmer. Pumpen stoppes under avlesingen. Kontroller at pumpen starter igjen
etter at avlesingen er fullført.

FORSIKTIG! Bruk ikke fjernkontrollen mens pumpen leses av. Hvis pumpens batteri har lite
strøm, sender ikke pumpen data til  datamaskinen. Bytt batteriet hvis statusen angir at

batteriet har lite strøm.

1 Klikk på pasientens fane eller dobbeltklikk på pasientens navn i tabellen Patient Lookup

(Pasientsøk).

2 Kontroller at pasientens utstyr kommuniserer med datamaskinen. (Se Koble til utstyr på

side 24.)

3 Klikk på Utstyr-knappen for å åpne arbeidsområdet Devices (Utstyr)  for pasienten.

Utstyret kan være oppført med et tilsvarende navn. Se Utstyr som støttes på side 2.

4 Finn utstyret du ønsker å hente data fra, på listen Active Devices (Aktivt utstyr)  og

kontroller at dataene under Choose port (Velg port)  er riktige.

Klikk på nedtrekksmenyen Amount of Data (Datamengde)  hvis utstyret er en pumpe, og

velg hvor mange pumpedata du vil at CareLink Pro skal lese av.

5 Klikk på den tilhørende knappen for READ DEVICE (Les av utstyr).

6 Følg spesifikke instruksjoner for utstyret og klikk på OK.

7 En fremdriftsindikator i CareLink Pro angir hvor stor del av avlesingen som er fullført.

Hvis du klikker på CANCEL (Avbryt) under avlesingen, vises det en melding om at du kan

miste alle dataene som er lest av så langt, hvis du avbryter handlingen. Du må klikke på

READ DEVICE (Les av utstyr) for å starte opplastingen på nytt.

- Klikk på YES (Ja)  for å avbryte.

- Klikk på NO (Nei)  hvis du vil fortsette avlesingen.

Når systemet er ferdig med å lese av dataene fra utstyret, vises det en melding der det

bekreftes at avlesingen er fullført.

8 Klikk på OK.

- Følg instruksjonene for å deaktivere stoppmodus hvis utstyret er en pumpe.

Hvis CareLink Pro ikke klarer å hente data fra utstyret,  finner du mer informasjon under

Feilsøking.
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6

Rapporter

CareLink Pro-programvaren kan lage en rekke rapporter som kan hjelpe deg til  å håndtere

pasientenes diabetesbehandling bedre. Informasjonen i  hver rapport er basert på dataene du

innhenter fra pasientens utstyr og pasientens CareLink Personal-konto.

Rapportene kan lages på skjermen, sendes direkte til en skriver eller lagres som TIFF- eller

PDF-filer som kan legges ved en elektronisk pasientjournal (EPJ).  Du kan lage flere typer

rapporter i  en enkelt handling.

Dataene som vises i disse rapportene, hentes fra pasientens utstyr,  fra pasientens CareLink

Personal-konto eller fra begge stedene.

MERK! Du finner mer informasjon om rapportene samt eksempler på rapportene i

Referansehåndbok for rapporter.  Du åpner Referansehåndbok for rapporter via CareLink

Pro-programvaren ved å gå til  Help > View Report Reference Guide (PDF) (Hjelp > Vis
Referansehåndbok for rapporter (PDF)) og velge det aktuelle språket.

Før du begynner

Hvis du vil  vise data fra en bestemt periode i en rapport,  må du hente data fra pasientens

utstyr for den perioden. Det kan også hende at du må koble pasientens utstyr til

datamaskinen og hente aktuelle data før du kan lage rapporter.
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Sørg for at du går gjennom trinnet Verify Report Settings (Kontroller rapportinnstillinger)
før du lager en rapport.  Her kan du fininnstille en rapport slik at du får med de pasientdataene

du ønsker.

Lage rapporter

Avsnittene nedenfor gir deg en bedre forståelse av de tilgjengelige rapportene og

fremgangsmåten for å lage dem.

Hvis du er kjent med fremgangsmåten og vet hvilke rapporter du ønsker å lage, kan du

begynne å generere rapporter.

Åpne arbeidsområdet Reports (Rapporter) 

Klikk på pasientfanen eller klikk på Åpne pasient-knappen  og dobbeltklikk på pasientens

navn.

Arbeidsområdet Reports (Rapporter)  vises.

MERK! Klikk på SYNC DATA (Synk. data) for å sikre at du har de siste utstyrsdataene fra

pasientens CareLink Personal-konto.

Velge rapportperiode

1 Hvis du vil endre hvor lang tid rapporten(e) skal omfatte, klikker du på nedtrekksmenyen

Duration (Varighet)  og velger tidsrom. (Maksimal varighet er 12 uker.)

2 Fra og med- og til og med-dato stilles inn automatisk, med mindre du velger alternativet

custom date range (egendefinert datointervall).

MERK! Hvis du velger et lengre datointervall enn det som er tillatt, får du en
feilmelding. Endre varigheten eller datoene.

Hvis du vil stille inn datoene selv, klikker du på nedtrekksmenyen From (Fra og med)  eller

Through (Til og med)  og velger ønsket måned, dato eller år.

Kalender

Kalenderfeltet i  arbeidsområdet Reports (Rapporter) viser rapportinformasjon for tre måneder.
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De blå søylene representerer utstyrsdata. Den oransje søylen representerer rapportperioden

du har valgt.  Overlapping mellom utstyrsdataene og rapportperioden betyr at det fins data for

deler av eller hele rapportperioden som vises.

Til  å begynne med vises de tre siste månedene i kalenderfeltet.  Hvis du vil se andre måneder,

klikker du på pilknappene  på begynnelsen eller slutten av perioden.

Velge data som skal tas med 

1 Hvis pasienten bruker en blodsukkermåler som kobles til pumpen, må du velge et av

følgende alternativer for rapportering av data fra blodsukkermåleren:

- Fra pumpen: Fordelene med dette valget er blant annet at du bare trenger å lese av data

fra pasientens pumpe. Blodsukkerverdiene er tidsstemplet av pumpen og verdiene

knyttet direkte til eventuelle Bolus Wizard-beregninger som brukes. En ulempe er at hvis

det oppstår kommunikasjonsproblemer mellom pumpen og blodsukkermåleren, kan det

hende at det ikke rapporteres blodsukkerverdier for den perioden. Dessuten, hvis

pasienten har en MiniMed Paradigm-pumpe som er eldre enn 522/722-modellen,

rapporteres ikke blodsukkerverdier fra Bolus Wizard-beregninger hvis pasienten ikke gjør

noen endringer på grunnlag av verdiene.

- Fra blodsukkermåleren/-målerne:  Fordelen med dette valget er at alle verdiene som lagres

i den tilkoblede blodsukkermåleren, rapporteres. Ulempen er at du må sørge for at

pumpens og blodsukkermålerens klokker er synkronisert for at dataene fra

blodsukkermåleren og pumpen skal kunne samordnes. Du må også lese av data fra

pumpen og blodsukkermåleren separat.

2 Merk av i boksen ved siden av utstyret hvis du vil at data fra utstyret skal tas med i

rapportene.

Du kan ikke legge til utstyr som er utelukket på grunn av valget du tok i trinn 1. Hvis du vil

endre dette, velger du det andre alternativet for rapportering av data fra blodsukkermåleren.

3 Fjern merket i boksen ved siden av utstyret hvis du ikke vil at data fra det utstyret skal tas

med i rapportene.

Du kan ikke fjerne merket fra utstyr som er tatt med på grunn av valget du tok i trinn 1. Hvis

du vil endre dette, velger du det andre alternativet for rapportering av data fra

blodsukkermåleren.
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Kontrollere om det finnes utstyrsdata

1 Se på kalenderfeltet i  arbeidsområdet Reports (Rapporter) og legg merke til om det er

overlapping mellom den oransje søylen som representerer rapportperioden, og de blå

søylene som representerer utstyrsdata.

2 Hvis det er overlapping for hele rapportperioden, har du data til rapporten(e). Du kan klikke

på NEXT (Neste)  og gå til Kontrollere rapportinnstillinger på side 40.

3 Hvis det ikke er noen overlapping, eller hvis det ikke er nok overlapping, har du noen valg:

- Endre rapportperioden.

- Hente ytterligere utstyrsdata.

Hente ytterligere utstyrsdata 

1 Klikk på knappen READ DEVICE (Les av utstyr)  for utstyret hvis du vil hente flere data fra

utstyret.

Feltet for avlesing av utstyret vises.

ADVARSEL! Avbryt eller fullfør alle midlertidige basaldoser eller aktive bolusdoser og
slett alle aktive alarmer. Pumpen stoppes under avlesingen. Kontroller at pumpen

starter igjen etter at avlesingen er fullført.

FORSIKTIG! Bruk ikke fjernkontrollen mens pumpen leses av. Hvis pumpens batteri

har lite strøm, sender ikke pumpen data til  datamaskinen. Bytt batteriet hvis

statusbildet på utstyret angir at batteriet har lite strøm.

2 Kontroller at dataene i feltet Choose port (Velg port)  stemmer for utstyret.

Hvis du vil endre denne innstillingen, klikker du på nedtrekksmenyen for feltet og velger en

annen innstilling.

3 Kontroller at utstyret er koblet til datamaskinen.

4 Hvis utstyret er en pumpe, kan du angi hvor mye data du vil hente fra den. Klikk på

nedtrekksmenyen Amount of Data (Datamengde)  og velg mengde.

MERK! Hvis du velger All available data (Alle tilgjengelige data),  leser systemet av
alle dataene fra pumpen. Dermed overskrives alle doble data i  systemet.
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5 Klikk på READ DEVICE (Les av utstyr). Pass på at du leser meldingen som vises nøye fordi

den inneholder konkrete instruksjoner for avlesing av pumpen.

6 Følg instruksjonene og klikk på OK.

Fremdriftsindikatoren for avlesing av utstyr vises.

Du kan avbryte avlesingen når som helst ved å klikke på CANCEL (Avbryt).

Det vises en bekreftelsesmelding om at avlesingen er fullført.

7 Klikk på OK.

Det vises nå utstyrsdata i kalenderen.

8 Klikk på NEXT (Neste)  øverst i  arbeidsområdet Reports (Rapporter).

Trinnet Verify Report Settings (Kontroller rapportinnstillinger) vises. Her kan du kontrollere at

innstillingene for denne pasienten er riktige før du lager rapporten(e).

Kontrollere rapportinnstillinger

1 Kontroller at innstillingene for Glucose Target (Målområde for glukoseverdier)  er riktige.

Skriv inn disse verdiene eller klikk på pil opp eller pil ned i feltene Low (Lav) og High (Høy)
for å øke eller senke verdiene.

MERK! Markører for blodsukkermåling (||  |)  vises på tidslinjen for oppvåkning og
leggetid, samt på tidslinjen for måltidsmarkører. Ettersom noen av rapportene er

basert på data som befinner seg innenfor definerte tidsrom for måltider, oppvåkning

eller leggetid, er det viktig at en pasients Bolus Wizard-hendelse og markørene for
blodsukkermåling er riktig gruppert.

2 Klikk på ADD MEAL (Legg til måltid) hvis du vil legge til en ny måltidsperiode. Klikk hvor

som helst innenfor en av måltidsperiodene langs tidslinjen for å redigere en eksisterende

måltidsperiode.

Vinduet for redigering av måltidsperioder, under tidslinjen, blir aktivt.

MERK! Du kan ha opptil fem måltidsperioder. Standardinnstillingene er frokost,  lunsj

og middag.

3 Skriv inn tekst eller klikk på pilene for å velge de innstillingene du ønsker.

Hvis du vil bruke disse innstillingene på bare dette måltidet, må du fjerne merket i boksen

Use these parameters for all of this patient's meals (Bruk disse innstillingene på alle
måltider for denne pasienten).

- Meal Name (Måltidsnavn):  navnet du vil gi måltidsperioden.

- Meal Time Period (Tidsintervall for måltidet): tidsintervallet for måltidet

- Pre-Meal BG Target (Målområde for glukoseverdi før måltidet) (mg/dL eller

mmol/L):  øvre og nedre målområde for pasientens glukoseverdi før måltidet.
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- Pre-Meal Analysis Period (Tidsrom for analyse før måltid):  hvor lenge

glukoseverdiene skal analyseres før starten på måltidet. Glukoseverdiene som registreres

i denne perioden, brukes i en detaljert rapportanalyse.

- Post-Meal BG Target (Målområde for glukoseverdi etter måltidet) (mg/dL eller
mmol/L):  øvre og nedre målområde for pasientens glukoseverdi etter måltidet.

- Post-Meal Analysis Period (Tidsrom for analyse etter måltid):  hvor lenge

glukoseverdiene skal analyseres etter måltidet. Glukoseverdiene som registreres i denne

perioden, brukes i en detaljert rapportanalyse.

Du kan endre lengden på en eksisterende måltidsperiode eller morgen- og

leggetidperioden ved å klikke på start- eller sluttlinjen og dra perioden langs tidslinjen.

MERK! Måltidsperiodene kan ikke overlappe hverandre, men start- og sluttlinjene kan
tangere hverandre. Tidsperiodene må være minst 60 minutter lange.

4 Hvis du vil bruke innstillingene for dette måltidet på alle de andre måltidene for pasienten,

må du kontrollere at boksen ved siden av Use these parameters for all of this patient’s

meals (Bruk disse innstillingene på alle måltidene for denne pasienten)  er merket av.

5 Klikk på SAVE (Lagre)  når du er ferdig med å opprette eller redigere en måltidsperiode.

6 Klikk på DELETE MEAL (Slett måltid) hvis du vil slette en måltidsperiode. Klikk på DELETE

(Slett)  når du blir bedt om å bekrefte.

7 CareLink Pro kan huske disse innstillingene for denne pasienten neste gang du skal lage en

rapport for pasienten. Klikk på SAVE SETTINGS (Lagre innstillinger)  for å lagre

innstillingene for denne pasienten.

8 Klikk på NEXT (Neste)  øverst i  arbeidsområdet Reports (Rapporter).
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I dette trinnet kan du velge og lage rapporter. Du kan velge en liste med rapporttyper eller

en datatabell som hjelper deg med å velge å ta med eller utelate data for visse dager i Daily

Detail (Daglig detaljer)-rapporten(e).

MERK! Klikk på >>customize columns (definer kolonner) hvis du vil endre hvordan

datatabellen vises. Se Innstillinger for rapportgenerering på side 16.

9 Klikk på UTSKRIFT-ikonet  hvis du vil skrive ut skjermbildet.

Velge rapporttyper og datoer som skal tas med

1 Merk av i boksen ved siden av rapporten(e) du vil ta med i rapportoppsettet.

2 Hvis det er lest av data fra en pumpe eller Guardian-monitor mer enn en gang i denne

rapportperioden, kan det hende det fins flere sammendrag av utstyrsinnstillingene:

a. Kontroller at boksen ved siden av Device Settings Snapshot (Sammendrag av

utstyrsinnstillinger) er merket av.

b. Klikk på pilen i datofeltet og velg dato og klokkeslett for sammendraget.

- Pumper:  Velg et sammendrag fra pasientens pumpe.

- Guardian:  Velg et sammendrag fra pasientens Guardian-monitor.

Hvis et av feltene er nedtonet, fins det ingen sammendrag for rapportperioden.

3 Bla gjennom datatabellen for å se gjennom informasjonen som er tilgjengelig for Daily Detail

(Daglig detaljer)-rapportene.
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- Du kan sortere dataene i hver kolonne. Klikk på kolonneoverskriften hvis du vil sortere

dataene i stigende rekkefølge. Klikk på kolonneoverskriften en gang til for å sortere

dataene i synkende rekkefølge.

MERK! Hvis det ikke finnes data for en bestemt dato, kan ikke datoen velges.

4 Merk av i boksen på datatabellradene for de datoene du ønsker en Daily Detail (Daglig

detaljer)-rapport for.

- Du kan ta med eller velge bort alle datoene for Daily Detail (Daglig detaljer)-rapporter

med et klikk, ved å merke av i boksen øverst i avmerkingskolonnen i datatabellen.

Lage rapporter

1 Etter at du har kontrollert rapportinnstillingene, klikker du på GENERATE REPORTS (Lag

rapporter)  øverst i arbeidsområdet Reports (Rapporter).

Det vises en liste med alternativer.

2 Velg om du vil forhåndsvise, skrive ut eller lagre rapporten(e).

Hvis du velger Preview (Forhåndsvisning),  vises vinduet Preview (Forhåndsvisning).

3 Klikk på pilknappene for å navigere gjennom rapporter på flere sider.

4 Klikk på en av de andre knappene øverst i  vinduet Preview (Forhåndsvisning) hvis du vil

lagre eller skrive ut rapporten(e).

5 Lukk dette vinduet ved å klikke på Lukk-knappen  i øvre høyre hjørne av vinduet.

Om rapporter

I  denne delen beskrives de forskjellige rapportene. Du finner mer informasjon om rapportene

samt eksempler på rapportene i Referansehåndbok for rapporter.  Du kan åpne

Referansehåndbok for rapporter via CareLink Pro-programvaren:

1 Help > View Report Reference Guide (PDF)  (Hjelp > Vis Referansehåndbok for rapporter

(PDF)).

2 Velg et språk for Report Reference Guide.

CareLink Pro-rapporter har følgende elementer til felles:

• Overskrift — Overskiften inneholder informasjon som identifiserer rapporten, for eksempel

rapportens navn, pasientens navn og hvor dataene kommer fra.

• Karbohydrater og blodsukkerverdier  — Karbohydratenheter vises i kursiv og

blodsukkerverdier vises i fet skrift på kurver og i tabeller.

• Helgedata  — Helgedager står i fet skrift slik at de er lette å se.
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• Symbolforklaringer  — Det vises en liste med symbolforklaringer nederst på hver rapport.

Selv om symbolene brukes i flere rapporter, er symbolforklaringene unike for hver rapport.

Rapporten Adherence (Respons)

Rapporten Adherence (Respons) inneholder data om hvordan insulinpumper og sensorer

brukes, samt pasientadferd som har betydning for behandlingen. Rapporten besvarer

spørsmålet:  "Var det tilstrekkelig data til å gi  et nøyaktig bilde av hvordan pasienten bruker

insulinpumpen og sensoren, hvis dette er aktuelt?" Den besvarer også spørsmålet:  "Følger

pasientene behandlingen som foreskrevet?" Den viser også om du trenger å snakke med

pasienten om hvordan han eller hun håndterer diabetesen.

Rapporten Sensor and Meter Overview (Oversikt over sensoren og
blodsukkermåleren)

Rapporten Sensor and Meter Overview (Oversikt over sensoren og blodsukkermåleren)

inneholder en grafisk oversikt over pasientens daglige glukoseverdier og

gjennomsnittsverdier fra sensoren og blodsukkermåleren og viser blant annet data per time

for hele døgnet og hvordan verdiene er i  forhold til  måltids- og søvnmønster. Rapporten

inneholder også statistikk over pasientens glukoseverdier og insulinbruk.

En lignende analyse av sensordata genereres på forsiden av denne rapporten hvis det

foreligger sensordata. Hvis det ikke foreligger sensordata, inneholder forsiden dataene fra

blodsukkermåleren.

De siste sidene av rapporten viser graden og kvaliteten på pasientens glykemiske kontroll,

registrering av karbohydrater og insulindoser dag for dag. På hver side vises det hvordan

kontrollen har variert fra dag til  dag i  hele rapportperioden med maksimalt 14 dager per side.

Rapporten Logbook (Loggbok)

Rapporten Logbook (Loggbok) viser glukose-,  karbohydrat- og insulindata fra

blodsukkermåleren for hver dag i rapportperioden. Den inneholder en oversikt over

registrerte hendelser per time, samt daglige gjennomsnittsverdier og totalverdier.  Hver side

inneholder opptil 14 dager. Hvis rapportperioden er lengre enn 14 dager, lages det ekstra

sider.

Rapporten Device Settings Snapshot (Sammendrag av utstyrsinnstillinger)

Rapporten Device Settings Snapshot (Sammendrag av utstyrsinnstillinger) inneholder et

sammendrag av innstillingene for pasientens pumpe eller Guardian REAL-Time-monitor på en

konkret dato og et konkret klokkeslett.  Den kan hjelpe deg med å forstå andre rapporter eller

bare dokumentere pasientens innstillinger.

Pumpe- eller monitorinnstillingene registreres bare når utstyret leses av. Hvis utstyret ikke har

vært lest av i  rapportperioden, er det ingen tilgjengelige innstillinger.
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Rapporten Daily Detail (Daglig detaljer)

Rapporten Daily Detail (Daglig detaljer) viser glukosedata, karbohydratmengde og pasientens

insulinbruk for den valgte dagen. Det lages en egen rapport for hver dag du velger i

datatabellen.

Rapporten Daily Detail  (Daglig detaljer) inneholder en detaljert oversikt for hver dag du

velger. Du kan bruke rapporten til  å fokusere på en bestemt dag hvis du tror det kan ha skjedd

noe som har betydning for pasientens behandling den dagen.

Eksportere data

Du kan eksportere utstyrsdata som samles inn og lagres i CareLink Pro. Du får da alle dataene

fra en pasients utstyr,  slik at du kan bruke dem til  statistikk eller til å lage spesialrapporter eller

-diagrammer. CSV-filen kan importeres til  Microsoft Excel eller visse kliniske

statistikkprogrammer der du kan bearbeide dataene ytterligere.

CSV-filen inneholder data om utstyrets aktiviteter.  Den viser for eksempel registrerte verdier

fra blodsukkermåleren, hvilken pumpe som har mottatt verdien fra blodsukkermåleren og

endringer i  basaldosen.

MERK! Dette er en avansert funksjon og forutsetter at du er kjent med rådataene fra

utstyret.  Funksjonen forutsetter også at du mestrer programvaren du importerer CSV-filen
til.

Gjør følgende når du skal bruke eksportfunksjonen i CareLink Pro:

1 Klikk på pasientfanen eller klikk på Åpne pasient-knappen  og dobbeltklikk på

pasientens navn.

2 Kontroller at arbeidsområdet Reports (Rapporter) vises.

3 Velg datoer og rapportlengde i feltet Duration (Varighet)  eller From/Through (Fra og

med / Til og med).

Den lengste perioden du kan velge, er 12 uker.

4 Klikk på lenken export selected data (eksporter valgte data).

Dialogboksen Export Data to CSV File (Eksporter data til CSV-fil) vises.

5 Naviger til stedet der du ønsker å lagre CSV-filen på datamaskinen. Hvis du vil endre navnet

på filen, skriver du navnet inn i feltet File name (Filnavn).

6 Klikk på SAVE (Lagre).

MERK! Du finner mer informasjon om dataene som vises i  CSV-filer,  i  vedlegget om

CSV-data.
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CSV-filen er nå lagret på datamaskinen med den plasseringen du valgte. Du kan nå velge å

importere filen inn i et annet program som støtter denne filtypen.
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7

Systemadministrasjon

Det er viktig at du regelmessig tar sikkerhetskopi av CareLink Pro-databasen. Databasen lagrer

alle data i pasientjournaler,  inkludert profilinformasjon, beregnede utstyrsdata og

rapportinnstillinger.

Det er også viktig at du bruker den nyeste versjonen av CareLink Pro. Det utgis jevnlig

oppdaterte versjoner, og disse kan inneholde viktige forbedringer. Du kan velge om du vil

søke etter oppdateringer eller få melding når en ny oppdatering er tilgjengelig.

Laste ned programvareoppdateringer 

Det utgis oppdateringer av CareLink Pro-programvaren med jevne mellomrom. Følg trinnene

nedenfor når du får melding om en oppdatering, slik at du får lastet ned den nyeste

programvaren.

MERK! Du bør ta en sikkerhetskopi av databasen før du legger inn en

programvareoppdatering. Se Sikkerhetskopiere databasen på side 48.

1 Kontroller at datamaskinen er koblet til Internett.

2 Du får en melding når det finnes en oppdatering av CareLink Pro. Deretter kan du velge å

laste ned oppdateringen.

3 Klikk på DOWNLOAD (Last ned).  (Hvis du klikker på CANCEL (Avbryt),  lukkes meldingen om

oppdateringen. Du kan laste ned oppdateringen senere.)

Det vises en advarsel som anbefaler at du tar en sikkerhetskopi av databasen.

4 Klikk på YES (Ja)  for å sikkerhetskopiere databasen (se mer om dette under Sikkerhetskopiere

databasen på side 48). Klikk på NO (Nei)  hvis du allerede har tatt en sikkerhetskopi.

Det vises en melding som bekrefter at den nye CareLink Pro-versjonen er lastet ned.

5 Klikk på YES (Ja)  for å bruke den nye CareLink Pro-versjonen. Programmet lukkes og åpnes

igjen. Klikk på NO (Nei) hvis du vil vente med å lukke CareLink Pro og åpne det igjen.
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Deaktivere automatiske oppdateringer

Følg instruksjonene nedenfor hvis du ikke vil motta automatiske meldinger om CareLink Pro-

oppdateringer:

1 Gå til Tools > Options (Verktøy > Alternativer).

2 Klikk på fanen General (Generelt).

3 I delen Communications (Kommunikasjon) fjerner du merket i boksen ved siden

Automatically check for software updates (Se etter programvareoppdateringer

automatisk).

Søke etter oppdateringer manuelt

Du kan søke etter CareLink Pro-oppdateringer manuelt når som helst.

MERK! Du bør ta en sikkerhetskopi av databasen før du legger inn en

programvareoppdatering. Se Sikkerhetskopiere databasen på side 48.

1 Kontroller at datamaskinen er koblet til Internett.

2 Gå til Tools > Check for Software Updates (Verktøy > Søk etter programvareoppdateringer).

3 Du får en melding hvis det ikke finnes nye oppdateringer. Hvis det finnes en ny CareLink Pro-

oppdatering, vises melding om dette.

4 Følg instruksjonene i Laste ned programvareoppdateringer på side 47.

Sikkerhetskopiere og gjenopprette databasen

Du bør lage en rutine for sikkerhetskopiering slik at du utfører den til  faste tider. Dette vil

gjøre det enklere å sikkerhetskopiere regelmessig og redusere risikoen for tap av data.

Hvis du sikkerhetskopierer eller gjenoppretter databasen, viser systemet en melding hvis det

er aktive brukere av programvaren på andre datamaskiner.

Sikkerhetskopiere databasen

Følg instruksjonene nedenfor når du skal ta en sikkerhetskopi av databasen og lagre den på

valgt sted.

1 Sørg for at alle pasientjournaler er lukket.

2 Gå til Tools > Backup Database  (Verktøy > Sikkerhetskopier database).

MERK! Sikkerhetskopier kan lagres på en nettverksstasjon eller på et flyttbart medium

(f.eks. DVD, CD, USB-pinne).

3 Naviger til stedet der du ønsker å lagre sikkerhetskopien på datamaskinen. Hvis du vil endre

navnet på sikkerhetskopien, skriver du navnet inn i feltet File name (Filnavn).

4 Klikk på Save (Lagre). En fremdriftsindikator vises mens databasen lagres.
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Det vises en melding når sikkerhetskopieringen er ferdig.

5 Klikk på OK for å lukke meldingen.

Gjenopprette databasen

Det kan hende du vil gjenopprette databasen hvis den ikke lenger fungerer eller du ikke får

tilgang til  den. Jo nyere sikkerhetskopien er,  jo mindre mengder data går tapt hvis du må

gjenopprette databasen.

FORSIKTIG! Når du gjenoppretter databasen fra en sikkerhetskopi,  mister du alle data som

er lagret i  den gjeldende databasen etter at sikkerhetskopien ble laget.

Følg instruksjonene nedenfor når du skal erstatte den aktuelle databasen med en

sikkerhetskopi.

1 Sørg for at alle pasientjournaler er lukket.

2 Gå til Tools > Restore Database (Verktøy > Gjenopprett database).

3 Velg sikkerhetskopifilen som skal erstatte den aktuelle databasen (vanligvis den nyeste).

4 Klikk på Open (Åpne).  Det vises en melding for å varsle om at data kan gå tapt hvis du

fortsetter gjenopprettingen av databasen.

5 Klikk på OK for å fortsette. En fremdriftsindikator vises mens databasen gjenopprettes.

Det vises en melding når gjenopprettingen er ferdig.

6 Klikk på OK for å lukke meldingen.

Hvis du ikke får tilgang til systemet

Hvis du prøver å bruke systemet mens en annen bruker holder på å sikkerhetskopiere eller

gjenopprette, får du en melding om at systemet ikke er tilgjengelig. Du får ikke tilgang til

systemet før kopieringen/gjenopprettingen er ferdig.

Gjør ett av følgende:

• Vent til prosessen er ferdig og systemet igjen er tilgjengelig.

• Klikk på CANCEL (Avbryt)  for å avbryte, og prøv igjen senere.
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Feilsøking

I  denne delen får du hjelp til å løse problemer som kan oppstå når du bruker CareLink Pro-

programvaren. Du finner også instruksjoner om hvordan du avinstallerer CareLink Pro-

programvaren om nødvendig.

Generelle feil under bruk

Det kan hende du får en melding om at du ikke har tilstrekkelige rettigheter hvis du prøver å

laste ned en programvareoppdatering fra Internett. Du må ha administratorrettigheter for å

laste ned CareLink Pro-programvareoppdateringer.

1 Lukk CareLink Pro-programmet og start datamaskinen på nytt.

2 Sørg for at en person med administratorrettigheter logger seg på datamaskinen.

3 Følg instruksjonene i Laste ned programvareoppdateringer på side 47.

Ikke koblet til databasen

Hvis du får en feilmelding om at du ikke er koblet til  databasen, angir det ett av følgende:

• Databasen er flyttet. Databasen må være plassert på stedet som ble valgt under

installasjonen av CareLink Pro-programvaren. Hvis databasen er flyttet, må du flytte den

tilbake til stedet som ble valgt under installasjonen.

• Du er ikke koblet til nettverksstasjonen der databasen finnes. Hvis databasen er på en

nettverksstasjon, kan midlertidige feil i nettverket hindre at du får tilgang til stasjonen.

Kontakt dataavdelingen for å få opprettet tilkobling til den nettverksstasjonen der databasen

finnes.
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Glemt passord til CareLink Pro

Hvis ingen kan huske passordet som diabetesteamet bruker til  å logge seg på CareLink Pro,

må CareLink Pro-programvaren installeres på nytt og en ny database opprettes. Når du har

installert programvaren på nytt,  har du ikke lenger tilgang til pasientinformasjonen som var i

den forrige databasen. Oppbevar passordet du opprettet under den nye installasjonen, på et

sted du husker, slik at du ikke mister fremtidige data.

Feil under avlesing av utstyr

Feil Forklaring

The selected serial port could not be opened. Another
operation might be in progress on that port. Please
wait until the port is  available, or select another port.

Kontroller at den valgte com-porten ikke brukes av
et annet program, eller velg en annen port. Start
datamaskinen på nytt og prøv å lese av utstyret
igjen. Det kan være feil på maskinvaren (f.eks.
kabelen) som er koblet til  porten, eller feil på selve
porten. Koble maskinvaren til en annen port og
prøve å lese av utstyret igjen for å finne ut om det
var problemet.

Auto Detect could not find the device on any available
port. Please check the cable connection, device battery
& status and try again, or try specifying a serial port.

Kontroller koblingen mellom kabelen og PC-en, og
kontroller at batteristatus er OK. Hvis dette
fungerer, kan du prøve å angi den serieporten på
PC-en som kabelen er koblet til,  i  stedet for å bruke
Auto Detect (Autom. registrering).

Device not found at selected serial port. Please check
the cable connection, device battery & status and try
again, try selecting a different port, or try to Auto
Detect the device.

Kontroller koblingen mellom kabelen og PC-en, og
kontroller at batteristatus er OK. Hvis dette
fungerer, kan du enten velge en annen serieport på
PC-en eller velge Auto Detect (Autom.
registrering).

Unable to communicate with the device. Please ensure
you’ve attached and selected the correct device, check
the cable connection, device battery and status, and try
again.

Kontroller alle innstillinger som er valgt for avlesing
av utstyret, inkludert utstyrsnavn, serienummer og
type tilkobling. Kontroller også at utstyret,  kabler
og PC-en er koblet til  riktig. Kontroller at utstyrets
batteri-  og alarmstatus er OK. Prøv avlesing igjen.

Unexpected response...  retrying (n%)

Systemet avleste en uventet verdi fra utstyret.
Systemet prøver å gjenoppta kommunikasjonen
inntil du avbryter eller kommunikasjonen
opprettes.

The link device was found, but the device (<serial #>) is
not responding. Please verify the device’s serial
number, place the device closer to the link device to
minimize signal interference, check device battery and
status.

Kontroller at riktig serienummer er lagt inn. Hvis
ikke må du skrive inn det riktige serienummeret.
Hvis serienummeret er riktig, kan du prøve å flytte
tilkoblingsutstyret nærmere
kommunikasjonsutstyret. Sørg for at
tilkoblingsutstyret og kommunikasjonsutstyret er
plassert på god avstand fra eventuelle forstyrrelser
(f.eks. annet RF-utstyr).  Kontroller utstyrets
batterinivå, og kontroller eventuelt insulinpumpens
tilførselsstatus ved opplading av insulinpumpe.

This pump is delivering a temp basal. Please cancel the
temp basal or wait until it completes, and then try
again.

Pumpen du prøver å avlese, holder på å tilføre en
midlertidig basaldose. Du må enten vente med
avlesing til den midlertidige basaldosen er ferdig,
eller avbryte basaldosen og deretter lese av
pumpen.

This device has active errors or alarms. Please clear the
alarms and try again.

Det finnes aktive alarmer i pumpen som hindrer
avlesing. Les i  alarminstruksjonene om hvordan du
sletter alarmen. Slett alarmen og prøv å lese av
pumpen igjen.
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Feil Forklaring

This pump is delivering a bolus. Please cancel the bolus
or wait until it completes, and then try again.

Pumpen du prøver å avlese, holder på å tilføre en
bolusdose. Du må enten vente med avlesing til
bolusdosen er ferdig, eller avbryte bolusdosen og
deretter lese av pumpen.

The device returned invalid entries; all data read will be
discarded.

Kontakt den lokale Medtronic-representanten (se
Brukerhjelp på side 2).

Feil under oppretting av rapport

Flere dataoppføringer på samme dato

Hvis det er flere dataoppføringer på samme dato og klokkeslett for det samme utstyret,

oppfatter systemet at det er en konflikt som det ikke kan løse. Rapporten for disse

utstyrsdataene vil ikke omfatte de dataene som overlapper.

Du kan eventuelt endre tidsrommet for rapporten slik at overlappende data ikke inkluderes.

Du kan også koble utstyret fra systemet og deretter til igjen for å slette tidligere data.

Systemet ignorerer data

Hvis klokkeslettet på utstyret er endret og dette medfører overlappende data eller manglende

data på tre timer eller mer, tar systemet ikke med den delen i rapportene.

Feil under sikkerhetskopiering og gjenoppretting

Databasen kan ikke låses

Dette betyr at systemet har flere brukere, og at andre brukere er logget på. Systemet tillater

ikke sikkerhetskopiering av databasen mens andre brukere kan utføre oppgaver som påvirker

databasen. Du kan ta sikkerhetskopi av databasen når alle andre brukere er logget av

CareLink Pro.

En sikkerhetskopiering eller gjenoppretting av databasen er ikke fullført

Andre brukere kan ikke logge på og sikkerhetskopieringen eller gjenopprettingen kan ikke

fullføres. Kontakt den lokale Medtronic-representanten (se Brukerhjelp på side 2).

Gjenoppretting av databasen mislyktes

Sikkerhetskopien av databasen du prøvde å bruke til å gjenopprette, er ødelagt. Bruk en

annen sikkerhetskopi til  gjenoppretting.

Avinstallere programvaren

Slik avinstallerer du CareLink Pro:

1 Åpne kontrollpanelet fra Start-menyen i Windows.

2 Velg Legg til eller fjern programmer.  Vinduet Legg til eller fjern programmer åpnes.

3 Bla ned til Medtronic CareLink Pro og marker dette.
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4 Klikk på Fjern. Installasjonsveiviseren åpnes.

5 Klikk på Neste.  En melding vises der du blir bedt om å bekrefte at du vil fjerne programmet.

6 Klikk på Ja. Avinstalleringsprogrammet fjerner programmet og alle filene fra datamaskinen.

Når programmet er fjernet, viser installasjonsveiviseren en melding som bekrefter

avinstalleringen.

7 Klikk på Ferdig.
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9

Symboloversikt

I  tabellen nedenfor finner du en beskrivelse av symbolene på emballasjen og utstyret.

Forklaring Symbol

Én per eske/pakning (1X)

CD er vedlagt

OBS! Les alle advarsler og forholdsregler i
bruksanvisningen.

Produksjonsdato (år)

Artikkelnummer

Conformité Européene (samsvar med europeisk
standard). Dette symbolet betyr at utstyret er fullstendig i
samsvar med MDD 93/42/EØF og R&TTE-direktivet 
1999/5/EF.
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A

CSV-data

Når du eksporterer rapportdata fra CareLink Pro-programvaren, blir de eksportert til en CSV-fil.

Denne filen kan så importeres til et regnearkprogram, for eksempel Microsoft Excel.  Nedenfor

finner du en fullstendig oversikt over dataene en CSV-fil kan inneholde.

CSV-filen inneholder pasientens navn og ID, rapportperioden og identifikasjon av hver enkelt

utstyrsenhet som er inkludert i  rapporten.

Definisjon av data i kolonner

Kolonneoverskrift Definisjon

Stikkordregister Rekkefølgen for registreringen av data i utstyret.

Date (Dato) Datoen for registreringen av data i  utstyret.

Time (Klokkeslett) Klokkeslettet for registreringen av data i utstyret.

New Device Time (Ny utstyrstid) Den nye datoen og det nye klokkeslettet, hvis dette
ble endret i  utstyret.

BG Reading (BS-verdi) (mg/dL eller mmol/L)

Blodsukkerverdien som ble registrert av
blodsukkermåleren, Guardian eller pumpen. Hvis
dataene kommer fra en pumpe eller Guardian, viser
kolonnen de manuelle BS-målingene eller BS-verdier
fra en Link-blodsukkermåler.

Linked BG Meter ID (ID for tilkoblet BS-måler) Serienummeret for den blodsukkermåleren som
sendte en bestemt BS-verdi til  utstyret.

Basal  Rate (U/h) (Basaldose (E/tim)) Den aktive basaldosen i enheter per time.

Temp Basal Amount (Midlertidig basaldose) Denne verdien viser den midlertidige basaldosen,
hvis en slik var programmert i  pumpen.

Temp Basal Type (Type midlertidig basaldose) Hvordan den midlertidige basaldosen justeres
(insulindose per time eller prosent av basal).

Temp Basal Duration (Varighet av midlertidig
basaldose) (m)

Hvor lenge tilførselen av den midlertidige basaldosen
varer, i  minutter (se type ovenfor).

Bolus Type (Bolustype) Type bolustilførsel [vanlig, forlenget, kombinasjon
(vanlig del) eller kombinasjon (forlenget del)].

Bolus Volume Selected (U) (Valgt bolusvolum (E)) Antall insulinenheter som er programmert til  å
tilføres under en bolustilførsel.
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Kolonneoverskrift Definisjon

Bolus Volume Delivered (U) (Tilført bolusvolum (E)) Antall insulinenheter som faktisk ble tilført under
bolustilførselen.

Programmed Bolus Duration (h) (Programmert
bolusvarighet (t))

Varigheten av en forlenget bolus eller den
forlengede delen av en kombinasjonsbolus.

Prime Type (Primetype)

Manuell eller fast. Manuell brukes rett etter en
reversering, for å fylle slangesettet med insulin før
det settes inn. Fast brukes etter at slangesettet er
satt inn for å fylle den myke kanylen med insulin
etter at innføringskanylen er fjernet.

Prime Volume Delivered (U) (Tilført primevolum (E)) Antall insulinenheter som faktisk ble tilført under
primingen.

Alarm Navnet på alarmen som oppsto.

Suspend (Stoppet) Angir at pumpen har stoppet.

Rewind (Reverser) Dato og klokkeslett for reversering.

BWZ Estimate (U) (BWZ-beregning (E)) Estimert bolusinsulin som er beregnet av Bolus
Wizard-funksjonen i Paradigm-pumpen.

BWZ Target High BG (BWZ-mål for høyt BS) (mg/dL
eller mmol/L)

Innstillingen for den øvre verdien av målområdet for
blodsukker -  brukes av Bolus Wizard.

BWZ Target Low BG (BWZ-mål for lavt BS) (mg/dL eller
mmol/L)

Innstillingen for den nedre verdien av målområdet
for blodsukker – brukes av Bolus Wizard.

BWZ Carb Ratio (BWZ-karbohydratforhold)

Innstillingen for insulin/karbohydrat-forholdet. Hvis
gram brukes som enheter, angir forholdet hvor
mange karbohydratgram som dekkes av en enhet
insulin. Hvis bytter brukes som enheter, angir
forholdet antall insulinenheter som dekker ett
karbohydratbytte.

BWZ Insulin Sensitivity (BWZ-insulinsensitivitet)

Innstillingen for insulinsensitivitet.
Insulinsensitiviteten er et tall på hvor mye
blodsukkerverdien reduseres når det tilføres én
enhet insulin. Dette brukes av Bolus Wizard.

BWZ Carb Input (BWZ-karbohydratoppføring) Antall karbohydrater som er lagt inn i  Bolus Wizard,
og som brukes til  å beregne en bolus.

BWZ BG Input (BWZ BS-oppføring) (mg/dL eller
mmol/L)

Blodsukkerverdier som er lagt inn i Bolus Wizard, og
som brukes til  å beregne en bolus.

BWZ Correction Estimate (U) (BWZ-
korreksjonsberegning (E))

Antall enheter som skal tilføres for å korrigere
blodsukkerverdien – beregnes av Bolus Wizard.

BWZ Food Estimate (U) (BWZ-matberegning (E))
Beregnet antall enheter som skal tilføres for å dekke
det forventede karbohydratinntaket – beregnes av
Bolus Wizard.

BWZ Active Insulin (U) (BWZ aktivt insulin (E))
Aktivt insulin som er beregnet til  å være igjen i
kroppen fra forrige bolustilførsel – brukes av Bolus
Wizard til  å beregne bolusdosen.

Sensor Calibration BG (Sensorkalibrering BS) (mg/dL
eller mmol/L)

BS-verdien som brukes til  å kalibrere sensoren (i
mg/dl eller mmol/l).

Sensor Glucose (Sensorglukose) (mg/dL eller mmol/L) Sensorglukoseverdien.

ISIG value (ISIG-verdi) Inngangssignaler (ISIG) som leses av sensoren. Målt i
nanoampere (nA).

Mer informasjon om CSV-filer som eksporteres av CareLink Pro

Tittelen øverst i  CSV-filen inneholder følgende informasjon:
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• pasientens navn

• en liste over valgt utstyr og tilhørende serienumre

• valgt datoområde

Hver kolonneblokk har en tittel med følgende informasjon:

• navn på utstyret som dataene gjelder for

• utstyrets serienummer

Hvis dataene ikke vises som forventet

Det kan være flere årsaker til at CSV-data vises annerledes enn forventet.

• Hvis dato eller klokkeslett endres på utstyret, kan det endre rekkefølgen eller føre til at

registreringer utenfor det valgte datoområdet vises.

• Hvis det er et stort opphold mellom utstyrsverdier, kan data for det utstyret vises i flere

blokker.
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Ordliste

A1C -  Glykosylert hemoglobin

A1C-test - Hemoglobin-A1C-test. Brukes til å vurdere blodsukkerverdier over en lengre tidsperiode.

Advarsel om lite i reservoar - Programmerbar advarsel som aktiveres når det er et definert antall
enheter igjen i reservoaret, eller at det er igjen en definert tid før reservoaret er tomt.

Arealet under kurven (AUK) - Angir antall høyeste og laveste avvik som definert av forhåndsinnstilte
verdier. Avviksdata angir hyppigheten av høye eller lave verdier. AUK angir størrelsen på hendelser
ved å vise hvor langt fra grenseverdier de var og i hvor lang tid.

Basaldose - Pumpeinnstilling som gir kontinuerlig infusjon av insulin for å holde blodsukkeret stabilt
mellom måltider og i løpet av natten. Basalinsulin fungerer på samme måte som insulin fra
bukspyttkjertelen – som dekker kroppens behov for insulin utenom mat.

Basaldoseprofil - En basaldose med et start- og stopptidspunkt. Brukeren kan programmere flere
forskjellige profiler i pumpen, hver med en egen dose, i løpet av en periode på 24 timer. Hensikten
med dette er å oppnå bedre blodsukkerkontroll.

Basalinsulin - En kontinuerlig infusjon av insulin per time som tilføres automatisk av en insulinpumpe
basert på forhåndsdefinerte profiler og personlige innstillinger i pumpen. Pumpen tilfører et
daglig program med insulindoser som normalt dekker det grunnleggende behovet for insulin ved
faste (f.eks. om natten og mellom måltider).

Basalprogrammer - Brukeren kan programmere opptil tre forskjellige programmer med basaldoser
for tilførsel av basalinsulin: Standard, A og B. For hvert program kan det innstilles opptil
48 basaldoseprofiler.

Blodsukkermåler - Et medisinsk apparat som brukes til å fastslå omtrentlig konsentrasjon av glukose
i blodet. En liten dråpe blod plasseres på en teststrimmel, som blodsukkermåleren leser av og
bruker til å beregne blodsukkerverdien. Blodsukkermåleren viser deretter verdien i mg/dl eller
mmol/l.

Blodsukkermålervalg - En funksjon som gjør at pumpen kan motta blodsukkerverdier fra en tilkoblet
blodsukkermåler.

Bolusinsulin - En insulindose som gis for å dekke forventet økning i blodsukkeret (f.eks. økning etter
et måltid eller mellommåltid) eller for å redusere høyt blodsukker til målområdet.

BS - Forkortelse for blodsukker

Bytteforhold - Insulinmengden som skal til for å dekke ett (1) karbohydratbytte. (Se også
Karbohydratforhold.)

CareLink® Personal - En nettbasert tjeneste som brukes til administrasjon av diabetesdata via
Internett.

ComLink - Et apparat med radiofrekvensmottaker, som brukes til å laste ned data fra Paradigm-
pumpen til datamaskinen.
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Com-Station - Et apparat som brukes til å laste ned data fra MiniMed 508-pumper og
blodsukkermålere fra andre produsenter.

Dual Wave®-bolus - (Kombinasjonsbolus). Kombinasjon av vanlig bolus som tilføres umiddelbart,
etterfulgt av en forlenget bolus. Den forlengede delen tilføres jevnt i et tidsrom.

Easy Bolus™ - Metode for tilførsel av en normal bolus ved hjelp av tasten Lydbolus på pumpen.

Ekspressbolus - Metode for tilførsel av alle bolustyper ved hjelp av tasten Ekspressbolus på pumpen.

Forlenget bolus-del - Andre del av en forlenget bolus. Forlenget bolus-delen tilføres jevnt over et
tidsrom etter at NÅ-delen er tilført.

Gjennomsnittlig absolutt avvik % (Mean Absolute Difference – MAD%) - Angir
kalibreringsnøyaktigheten av sensorverdier i forhold til blodsukkermålerens verdier. Jo lavere
dette tallet er, jo større er kalibreringsnøyaktigheten. MAD% kalkuleres ved å ta differensen
mellom nærliggende par av sensorglukose- og blodsukkerverdier og dividere dette tallet med BS-
verdier. Deretter beregnes et gjennomsnitt av alle parene.

HbA1c - Glykosylert hemoglobin

HbA1c-test - Hemoglobin-A1C-test. Brukes til å vurdere blodsukkerverdier eller gjennomsnittet av
verdiene over en periode på 2 til 3 måneder.

Hyperglykemisk - For høyt blodsukker. Dette oppdages ved kontroll av blodsukkerverdier, og kan
følges av et eller flere av følgende symptomer: kvalme, oppkast, uklart syn, hodepine,
mageproblemer, hyppig vannlating og nedsatt bevissthet.

Hypoglykemisk - For lavt blodsukker. Dette oppdages ved kontroll av blodsukkerverdier, og kan
følges av et eller flere av følgende symptomer: kraftig sultfølelse, skjelvinger eller kramper, svette,
"dansende" syn, svimmelhet, hodepine, uklar tale, plutselige humørsvinginger eller
personlighetsforandringer.

Høy glukose - Pumpen utløser en alarm hvis sensoren angir at brukerens glukoseverdi er lik eller
høyere enn denne verdien. Du kan velge om du vil slå denne funksjonen på eller av.

Insulinkonsentrasjon - Konsentrasjonen eller typen insulin som legen har foreskrevet. Dette
påvirker hastigheten som pumpen bruker for å tilføre insulinet. Hvis brukeren bytter
insulinkonsentrasjon, må basalprogrammer og maksimumshastigheter for basal- og bolusdoser
omprogrammeres i pumpen.

Insulinsensitivitet - Hvor mye blodsukkeret reduseres i mg/dl (eller mmol/l) når det tilføres én enhet
insulin. (Bolus Wizard-data.)

ISIG - Sensorverdier som indikerer at senderen i et sensorbasert system fungerer som den skal.
Kontakt den lokale representanten hvis ISIG-verdien er mindre enn 24,00 nA eller mer 29,00 nA.
Det kan være du må bytte senderen.

Kal.påminn. - Pumpen utløser automatisk alarmen BS-verdi kl. TT:MM hver 12. time for å angi at den
gjeldende kalibreringsverdien ikke lenger er gyldig. Verdien for kalibreringspåminnelsen kan
innstilles etter eget valg og er den tiden som gjenstår før den gjeldende kalibreringsverdien løper
ut. Hvis kalibreringspåminnelsen for eksempel er satt til 2 timer, utløses alarmen BS-verdi kl. TT:MM
2 timer før pumpen må kalibreres.

Karb.forhold - (karbohydratforhold). - Mengden karbohydrater som dekkes av én enhet insulin.
(Se også bytteforhold.)

Karbohydratenheter - Matoppføringen når Bolus Wizard brukes. Angis i gram (karbohydrater) eller
bytter.

Ketontest - Ketoner er et avfallsprodukt som produseres når kroppen blir tvunget til å omdanne fett
til energi i stedet for glukose. Det kan være et tegn på at kroppen mangler insulin. Ketontesten
måler konsentrasjonen av ketoner i blod eller urin.

KH - Karbohydrat

Korrigeringsbolusfaktor - Hvor mye blodsukkeret blir redusert med 1,0 enhet insulin. Denne
faktoren benyttes til å beregne korrigeringsdosen når blodsukkeret er høyt. (BG-nivå) - (BG-mål)
= X. X ÷ (korrigeringsbolusfaktor) = korrigeringsdose
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Korrigeringsdose - Insulinmengden som skal til for å redusere et høyt blodsukkernivå til
målområdet.

Laste opp - Prosessen med å overføre data fra pumpen eller blodsukkermåleren til CareLink®
Personal-serveren.

Lav glukose - Pumpen utløser en alarm hvis sensoren angir at brukerens glukoseverdi er lik eller
lavere enn denne verdien. Du kan velge om du vil slå denne funksjonen på eller av.

Link
(1) Aktivere og programmere blodsukkermålervalget som gjør at pumpen kan ta imot
blodsukkerverdier fra en blodsukkermåler som kommuniserer med pumpen.
(2) Det brukes også i systemet for å referere til lenker. Da kalles det lenke. Når du har logget deg
på, kan lenker åpne andre sider i systemet eller et annet nettsted.

Lydbolus - Pumpen kan programmeres slik at den avgir et lydsignal når en bolusdose (0,5 eller
1,0 enheter) tilføres. Dette er nyttig i situasjoner der det er vanskelig å se pumpens taster.

Maks. basalinsulin - Den maksimale insulinmengden som pumpen kan tilføre på én gang. (Angitt
av brukeren.)

Maksimal bolus - Den maksimal bolusmengden som pumpen kan tilføre på én gang. (Angitt av
brukeren.)

Manuell bolus - Valgbart element i BOLUSMENY når Bolus Wizard er aktivert. En metode for
programmering av bolus uten Bolus Wizard.

Matbolus - En insulindose som tilføres for å dekke den forventede økningen av blodsukkeret som
oppstår etter et måltid.

Midl. - Midlertidig

Midlertidig basaldose (midl. basal) - Midlertidig basalinsulin som tilføres én gang med spesifikk
mengde og varighet. Brukes til å dekke insulinbehov ved spesielle aktiviteter eller tilstander som
ikke er en del av den normale, daglige rutinen.

Programfunksjon - Utvidet pumpefunksjon. Ved hjelp av denne kan du programmere valgfrie
basaldoser (Program A, Program B) hvis du utfører aktiviteter eller har glukosemønstre som ikke
er en del av din daglige rutine, men som er vanlige for din livsstil. Det kan for eksempel dreie seg
om en idrett du deltar i en gang i uken, en forandring i søvnmønsteret over helgen eller hormonelle
forandringer i løpet av menstruasjonssyklusen.

RF - Radiofrekvens (RF)

Sender-ID - Serienummeret på senderen som brukes.

Slangesett - En slange som brukes mellom en kanyle under huden og pumpen for å tilføre insulin
til injeksjonsstedet.

Square Wave®-bolus - (Forlenget bolus). Bolus som tilføres over et spesifisert tidsrom (30 minutter
til 8 timer).

Standardprogram - Den normale basaldosen som er tilpasset hverdagens aktiviteter. Når
programfunksjonen er slått av, bruker pumpen ditt standardprogram (basal).

Stoppet - Funksjon som stopper all tilførsel av insulin. All bolustilførsel og/eller priming stoppes.
Basaltilførselen stoppes til den startes igjen.

Trinn - Måleenhet for insulin som du angir og bruker ved tilførsel av lydbolus.

Vanlig bolus - En umiddelbar tilførsel av en spesifisert insulindose.

CareLink Pro Brukerhåndbok   Ordliste 60



Stikkordregister

A

advarsler  5
aktivere utstyr  33
apne CareLink Pro  8

pålogging  8
arbeidsområdene  8

Å

åpne
rapporter  37

åpne CareLink Pro
skrive inn passordet  8

åpne pasientprofiler  10

B

Bayer Ascensia® DEX®
utstyr tilsvarende  4

Bayer Ascensia ELITE™ XL
utstyr tilsvarende  4

bestilling
blodsukkermålere  4
Medtronic MiniMed-produkter  4
Paradigm Link  4
pumper  4
utstyr  4

blodsukkermålere
aktivere  33
bestilling  4
deaktivere  33
ekstrautstyr til kommunikasjon med

datamaskinen  24
hente data  34
koble til datamaskin  24, 25, 26

datamaskintilkoblinger, serie  25
datamaskintilkoblinger, USB  25
ekstrautstyr, ComLink  26

koble til datamaskinen  25
datamaskintilkoblinger, serie  25
datamaskintilkoblinger, USB  25

legge til i systemet  30
slette  33
støttes  3

blodsukkermålere som støttes  2
blodsukkermålere som støttes av CareLink

Pro  3
blodsukkermålerkabel  4
blodsukkermålernavn

tilsvarende utstyr  4
brukergrensesnitt

Guide Me  9
navigere i  8
verktøylinjen  9

brukerhåndbok
ord, uttrykk og symboler  5
relevant dokumentasjon  2

brukersikkerhet
advarsler  5
indikasjoner for bruk  5
kontraindikasjoner for bruk  5

Brukerstøtte, kontakte  2

C

CareLink Personal
hente data  22
koble seg til en konto  21, 22

eksisterende konto  21
invitasjon på e-post  22

ComLink  4, 26
Com-Station  4
CSV-filer

eksportere utstyrsdata til  45

D

Daily Detail-rapport
om  45

database
gjenopprette fra sikkerhetskopi  49
sikkerhetskopiere  48

datakommunikasjonskabel  4
datakommunikasjonskabel som støttes  4

CareLink Pro Brukerhåndbok   Stikkordregister 61



datoer
velge for rapporter  42

deaktivere utstyr  33
dokumenter relevante for denne

brukerhåndboken  2

E

eksisterende CareLink Personal-konto
koble seg til  21

eksportere utstyrsdata  45
ekstrautstyr til kommunikasjon med

datamaskinen  26

F

feilsøking  50
forhåndsvisning

rapporter  43
forstå rapporter  43

Daily Detail-rapport  45
Loggbokrapport  44
Oversiktsrapport for sensoren og

blodsukkermåleren  44
Responsrapport  44
Sammendrag av utstyrsinnstillinger  44

funksjoner i CareLink Pro  1
sikkerhet  2

få beskjed om programvareoppdateringer  47

G

generelle innstillinger
definere  12

generelle systeminnstillinger
definere  11, 13, 14, 15, 16, 18

generelle innstillinger  11
innstillinger for pasientprofil  13
innstillinger for pasientprofil, endre

rekkefølgen på felter  14
innstillinger for pasientprofil, legge til

egendefinerte felter  14
innstillinger for pasientprofil, velge

datafelter  14
innstillinger for pasientsøk  14
innstillinger for pasientsøk, endre

rekkefølgen på kolonner  15
innstillinger for rapportgenerering,

endre rekkefølgen på kolonner  18
innstillinger for rapportgenerering,

velge data  16
innstillinger for åpne pasient, velge

data  15
forstå  11

generere rapporter  43
forhåndsvisning  43
lagre  43
skrive ut  43

gjenopprette databasen  49

grunnleggende CareLink Pro-oppgaver  7
Guardian-monitor

legge til i systemet  28
Guardian-monitorer

deaktivere  33
Guide Me-funksjon  9

H

hente en pasients utstyrsdata  34
hente utstyrsdata

fra CareLink Personal  22
koble seg til CareLink Personal  21, 22

eksisterende konto  21
invitasjon på e-post  22

nye data til rapporter  39
hvordan bruke denne brukerhåndboken  5

I

indikasjoner for bruk  5
innstillinger

kontrollere for rapporter  40
system  11, 12, 13, 14, 15, 16, 18

definere  11
definere, generelle innstillinger  12
definere, innstillinger for

pasientprofil  13
definere, innstillinger for

pasientprofil, endre rekkefølgen på
felter  14

definere, innstillinger for
pasientprofil, legge til
egendefinerte felter  14

definere, innstillinger for
pasientprofil, velge datafelter  14

definere, innstillinger for pasientsøk  14
definere, innstillinger for pasientsøk,

endre rekkefølgen på kolonner  15
definere, innstillinger for

rapportgenerering  16
definere, innstillinger for

rapportgenerering, endre
rekkefølgen på kolonner  18

definere, innstillinger for
rapportgenerering, velge data  16

definere, innstillinger for åpne
pasient, velge data  15

forstå  11
innstillinger for pasientprofil

definere  13, 14
endre rekkefølgen på felter  14
legge til egendefinerte felter  14
velge datafelter  14

innstillinger for pasientsøk
definere  15

endre rekkefølgen på kolonner  15

CareLink Pro Brukerhåndbok   Stikkordregister 62



innstillinger for rapportgenerering
definere  16, 18

endre rekkefølgen på kolonner  18
velge data  16

innstillinger for åpne pasient
definere  15

velge data  15
insulinpumper som støttes  2, 3
insulinpumper som støttes av CareLink Pro  3

K

kabler for tilkobling av utstyr til datamaskinen
serie  25
USB  25

knapper på verktøylinjen  9
koble seg til CareLink Personal-kontoer  21

eksisterende konto  21
hente data  22
invitasjon på e-post  22

koble utstyr til datamaskinen  24
datamaskintilkoblinger  25

serie  25
USB  25

ekstrautstyr  26
ComLink  26

forskjellige blodsukkermålere  24
kabler  25
oversikt  25

kommunikasjonsutstyr som støttes  2
kommunikasjonsutstyr som støttes av

CareLink Pro  4
kontraindikasjoner for bruk  5
kontrollere

om det fins utstyrsdata til rapporter  39
kontrollere rapportinnstillinger  40
kopiere databasen, sikkerhet  48

L

lage rapporter  37
forhåndsvisning  43
hente nye utstyrsdata  39
kontrollere om det finnes utstyrsdata  39
kontrollere rapportinnstillinger  40
lage din egen rapport  45
lagre  43
skrive ut  43
velge rapportperiode  37
velge rapporttyper og datoer som skal

tas med  42
velge utstyr  38
åpne arbeidsområdet Reports

(Rapporter)  37
lagre

rapporter  43
lagre en pasients utstyr i systemet  33

aktivere  33
deaktivere  33

laste ned programvareoppdateringer  47

legge en pasients utstyr til i systemet
blodsukkermålere  30
Guardian-monitor  28
pumper  28

legge til en blodsukkermåler i systemet  30
tilsvarende blodsukkermålere  4

legge til en Guardian-monitor i systemet  28
legge til en pasient  20
legge til en pumpe i systemet  28
legge til utstyr i systemet  28
Loggbokrapport

om  44
lukke pasientprofiler  11

M

maskinvaretilkoblinger  24
datamaskintilkoblinger  25

serie  25
USB  25

ekstrautstyr  26
ComLink  26

forskjellige blodsukkermålere  24
kabler  25
oversikt  25
USB  25

Medtronic MiniMed-produkter
bestilling  4

N

navigere i
arbeidsområdene  8

navigere i grensesnittet for CareLink Pro  8
navigeringsfelt

arbeidsområdene  8

O

om rapporter  43
Daily Detail-rapport  45
Loggbokrapport  44
Oversiktsrapport for sensoren og

blodsukkermåleren  44
Responsrapport  44
Sammendrag av utstyrsinnstillinger  44

oppdater programvare  47
opprette pasientprofiler  20
oversikt over CareLink Pro  1
Oversiktsrapport for sensoren og

blodsukkermåleren
om  44

P

Paradigm Link
bestilling  4

CareLink Pro Brukerhåndbok   Stikkordregister 63



pasientprofiler
lukke  11
opprette  20
redigere  20
åpne  10

password
skrive inn for CareLink Pro  8

PC
koble til utstyr  24, 25, 26

datamaskintilkoblinger, serie  25
datamaskintilkoblinger, USB  25
ekstrautstyr, ComLink  26
oversikt  25

produkt
oversikt  1

profiler
lukke  11
opprette  20
redigere  20
åpne  10

programvareoppdateringer  47
pumper

aktivere  33
bestilling  4
deaktivere  33
hente data  34
koble til datamaskin  24, 25, 26

datamaskintilkoblinger, serie  25
datamaskintilkoblinger, USB  25
ekstrautstyr, ComLink  26

koble til datamaskinen  25
datamaskintilkoblinger, serie  25
datamaskintilkoblinger, USB  25
eksempel  25

kommunisere med datamaskinen  35, 39
retningslinjer  35, 39

legge til i systemet  28
slette  33
støttes  3

pumper som støttes  2
pålogging

CareLink Pro  8

R

rapporter
forhåndsvisning  43
forstå  43
lage  37, 38, 39, 40, 42, 43

forhåndsvisning  43
hente nye utstyrsdata  39
kontrollere innstillinger  40
kontrollere om det finnes

utstyrsdata  39
lagre  43
skrive ut  43
velge rapportperiode  37

velge rapporttyper og datoer som
skal tas med  42

velge utstyr  38
åpne arbeidsområdet Reports

(Rapporter)  37
lage din egen  45
lagre  43
om  44, 45

Daily Detail-rapport  45
Loggbokrapport  44
Oversiktsrapport for sensoren og

blodsukkermåleren  44
Responsrapport  44
Sammendrag av utstyrsinnstillinger  44

skrive ut  43
rapporter-bilde

oversikt  36
rapportinnstillinger

kontrollere  40
rapportperiode

velg  37
rapporttyper

velge for rapporter  42
redigere pasientprofiler  20
relevant dokumentasjon  2
Responsrapport

om  44

S

Sammendrag av utstyrsinnstillinger
om  44

sende invitasjon til å opprette en CareLink
Personal-konto på e-post  22

serietilkoblinger  25
sikkerhet  5
sikkerhetsfunksjoner i CareLink Pro  2
sikkerhetskopiere databasen  48
skrive ut

rapporter  43
slette en pasients utstyr fra systemet  33
starte programvaren  8

pålogging  8
skrive inn passordet  8

støttet kommunikasjonsutstyr  2
symboler  54
systeminnstillinger

definere  11, 12, 13, 14, 15, 16, 18
generelle innstillinger  12
innstillinger for pasientprofil  13
innstillinger for pasientprofil, endre

rekkefølgen på felter  14
innstillinger for pasientprofil, legge til

egendefinerte felter  14
innstillinger for pasientprofil, velge

datafelter  14
innstillinger for pasientsøk  14
innstillinger for pasientsøk, endre

rekkefølgen på kolonner  15
innstillinger for rapportgenerering  16

CareLink Pro Brukerhåndbok   Stikkordregister 64



innstillinger for rapportgenerering,
endre rekkefølgen på kolonner  18

innstillinger for rapportgenerering,
velge data  16

innstillinger for åpne pasient, velge
data  15

forstå  11

T

tilsvarende utstyr
andre blodsukkermålere  4

U

USB-tilkoblinger  25
utstyr

aktivere  33
bestilling  4
deaktivere  33
eksportere data  45
hente data  34, 39

nye data til rapporter  39
hente utstyrsdata  34
koble til datamaskin  24, 25, 26

datamaskintilkoblinger, serie  25
ekstrautstyr, ComLink  26

koble til datamaskinen  25
datamaskintilkoblinger, serie  25
oversikt  25

kontrollere om det fins data til
rapporter  39

lagre i systemet  33
aktivere  33
deaktivere  33

lagre utstyr  33
aktivere  33
deaktivere  33

legge til i systemet  28, 30
blodsukkermålere  30
Guardian-monitor  28
pumper  28

legge til utstyr  28, 30
blodsukkermålere  30
Guardian-monitor  28
pumper  28

slette  33
slette fra systemet  33
slette utstyr  33
støttes  2, 3, 4

blodsukkermålere  3
ComLink  4
Com-Station  4
insulinpumper  3
kommunikasjonskabel for målerdata  4

støttes av CareLink Pro  2
velge for rapporter  38

utstyr som støttes  2
blodsukkermålere  3, 4

tilsvarende utstyr  4
blodsukkermålerkabel  4
ComLink  4
Com-Station  4
insulinpumper  3
kommunikasjonsutstyr  4

utstyrsdata
hente data fra CareLink Personal  22
hente fra en pasients utstyr  34
koble seg til CareLink Personal  21, 22

eksisterende konto  21
invitasjon på e-post  22

utstyrsdata på nett
hente dataene  22
koble seg til CareLink Personal  21, 22

eksisterende konto  21
invitasjon på e-post  22

V

velg
rapportperiode  37
rapporttyper og datoer som skal tas

med  42
utstyr for rapporter  38

verktøylinje for CareLink Pro
knapper  9

CareLink Pro Brukerhåndbok   Stikkordregister 65


	Innledning
	Funksjoner
	Sikkerhet
	Relevant dokumentasjon
	Brukerhjelp
	Utstyr som støttes
	Tilsvarende utstyr

	Bestilling
	Hvordan bruke denne brukerhåndboken
	Brukersikkerhet

	Komme i gang
	Før du begynner
	Grunnleggende systemoppgaver
	Navigere i systemet
	Åpne CareLink Pro
	Arbeidsområder
	Verktøylinje
	Pasientfaner
	Guide Me-funksjonen
	Slå Guide Me-funksjonen på og av


	Åpne pasientjournaler
	Lukke pasientjournaler
	Definere systeminnstillinger
	Generelle innstillinger
	Innstillinger for pasientprofil
	Velge datafelter
	Legge til egendefinerte felter
	Velge rekkefølgen på datafeltene
	Fullføre innstillingene for pasientprofil

	Innstillinger for pasientsøk
	Velge hvilke data som skal vises
	Endre rekkefølgen på kolonnene
	Fullføre innstillingene for pasientsøk

	Innstillinger for rapportgenerering
	Velge hvilke data som skal vises
	Endre rekkefølgen på kolonnene
	Fullføre innstillingene for rapportgenerering



	Profiler
	Før du begynner
	Legge til nye profiler
	Fylle ut obligatoriske felter

	Redigere pasientprofiler
	Slette pasientdata fra systemet
	Koble seg til CareLink Personal
	Koble seg til en eksisterende konto
	Sende invitasjon på e-post
	Hente data fra en tilkoblet konto
	Koble en pasients Carelink Personal-konto fra CareLink Pro


	Maskinvareoppsett
	Koble til utstyr

	Utstyr
	Før du begynner
	Legge til utstyr
	Legge til Medtronic-pumpe eller Guardian-monitor
	Legge til en blodsukkermåler

	Aktivere eller deaktivere utstyr
	Deaktivere utstyr
	Aktivere utstyr
	Slette utstyr

	Lese av utstyrsdata

	Rapporter
	Før du begynner
	Lage rapporter
	Åpne arbeidsområdet Reports (Rapporter)
	Velge rapportperiode
	Kalender

	Velge data som skal tas med
	Kontrollere om det finnes utstyrsdata
	Hente ytterligere utstyrsdata
	Kontrollere rapportinnstillinger
	Velge rapporttyper og datoer som skal tas med
	Lage rapporter

	Om rapporter
	Rapporten Adherence (Respons)
	Rapporten Sensor and Meter Overview (Oversikt over sensoren og blodsukkermåleren)
	Rapporten Logbook (Loggbok)
	Rapporten Device Settings Snapshot (Sammendrag av utstyrsinnstillinger)
	Rapporten Daily Detail (Daglig detaljer)

	Eksportere data

	Systemadministrasjon
	Laste ned programvareoppdateringer
	Deaktivere automatiske oppdateringer
	Søke etter oppdateringer manuelt

	Sikkerhetskopiere og gjenopprette databasen
	Sikkerhetskopiere databasen
	Gjenopprette databasen
	Hvis du ikke får tilgang til systemet


	Feilsøking
	Generelle feil under bruk
	Ikke koblet til databasen
	Glemt passord til CareLink Pro

	Feil under avlesing av utstyr
	Feil under oppretting av rapport
	Feil under sikkerhetskopiering og gjenoppretting
	Avinstallere programvaren

	Symboloversikt
	CSV-data
	Definisjon av data i kolonner
	Mer informasjon om CSV-filer som eksporteres av CareLink Pro
	Hvis dataene ikke vises som forventet


	Ordliste
	Stikkordregister


<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Gray Gamma 2.2)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Error
  /CompatibilityLevel 1.5
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages false
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /DetectCurves 0.1000
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedOpenType false
  /ParseICCProfilesInComments true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo false
  /PreserveCopyPage true
  /PreserveDICMYKValues true
  /PreserveEPSInfo false
  /PreserveFlatness true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Remove
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /CropColorImages true
  /ColorImageMinResolution 150
  /ColorImageMinResolutionPolicy /OK
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 150
  /ColorImageDepth -1
  /ColorImageMinDownsampleDepth 1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /ColorImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /AntiAliasGrayImages false
  /CropGrayImages true
  /GrayImageMinResolution 150
  /GrayImageMinResolutionPolicy /OK
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 150
  /GrayImageDepth -1
  /GrayImageMinDownsampleDepth 2
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /GrayImageDict <<
    /QFactor 0.76
    /HSamples [2 1 1 2] /VSamples [2 1 1 2]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 15
  >>
  /AntiAliasMonoImages false
  /CropMonoImages true
  /MonoImageMinResolution 1200
  /MonoImageMinResolutionPolicy /OK
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects true
  /CheckCompliance [
    /None
  ]
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile (None)
  /PDFXOutputConditionIdentifier ()
  /PDFXOutputCondition ()
  /PDFXRegistryName ()
  /PDFXTrapped /False

  /Description <<
    /CHS <FEFF4f7f75288fd94e9b8bbe5b9a521b5efa7684002000410064006f006200650020005000440046002065876863900275284e8e55464e1a65876863768467e5770b548c62535370300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c676562535f00521b5efa768400200050004400460020658768633002>
    /CHT <FEFF4f7f752890194e9b8a2d7f6e5efa7acb7684002000410064006f006200650020005000440046002065874ef69069752865bc666e901a554652d965874ef6768467e5770b548c52175370300260a853ef4ee54f7f75280020004100630072006f0062006100740020548c002000410064006f00620065002000520065006100640065007200200035002e003000204ee553ca66f49ad87248672c4f86958b555f5df25efa7acb76840020005000440046002065874ef63002>
    /DAN <>
    /DEU <>
    /ESP <>
    /FRA <>
    /ITA (Utilizzare queste impostazioni per creare documenti Adobe PDF adatti per visualizzare e stampare documenti aziendali in modo affidabile. I documenti PDF creati possono essere aperti con Acrobat e Adobe Reader 5.0 e versioni successive.)
    /JPN <>
    /KOR <FEFFc7740020c124c815c7440020c0acc6a9d558c5ec0020be44c988b2c8c2a40020bb38c11cb97c0020c548c815c801c73cb85c0020bcf4ace00020c778c1c4d558b2940020b3700020ac00c7a50020c801d569d55c002000410064006f0062006500200050004400460020bb38c11cb97c0020c791c131d569b2c8b2e4002e0020c774b807ac8c0020c791c131b41c00200050004400460020bb38c11cb2940020004100630072006f0062006100740020bc0f002000410064006f00620065002000520065006100640065007200200035002e00300020c774c0c1c5d0c11c0020c5f40020c2180020c788c2b5b2c8b2e4002e>
    /NLD (Gebruik deze instellingen om Adobe PDF-documenten te maken waarmee zakelijke documenten betrouwbaar kunnen worden weergegeven en afgedrukt. De gemaakte PDF-documenten kunnen worden geopend met Acrobat en Adobe Reader 5.0 en hoger.)
    /NOR <>
    /PTB <>
    /SUO <>
    /SVE <>
    /ENU (Use these settings to create Adobe PDF documents suitable for reliable viewing and printing of business documents.  Created PDF documents can be opened with Acrobat and Adobe Reader 5.0 and later.)
  >>
>> setdistillerparams
<<
  /HWResolution [250 250]
  /PageSize [612.000 792.000]
>> setpagedevice


